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Oops! and Legal Stuff  

 

While I have made every effort to ensure the accuracy of this document, including grammar and 

instructions, I make mistakes. (Surprise!)  If you find an error or want to provide constructive 

feedback, please contact me.  Thank you!  Enjoy Excelling at Excel and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

✓ International Association of Administrative Professionals Member 

✓ American Society of Training and Development Member 

✓ Society for Human Resource Management 

✓ Microsoft Certified Application Specialist – Instructor 

✓ Certified Technical Trainer + - CompTIA 

✓ A+ Certified through CompTIA 

✓ Microsoft Certified Technical Trainer 

 

Excel ® is a most excellent product from Microsoft ® Corporation and is part of the Office ® 

Suite of products and services.  

 

Copyright © 2018 Greg Creech, Techedutainment Services, Inc.  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any 

means, electronic or mechanical, including photocopying, recording, storage in an information 

retrieval system, or otherwise, without express written permission of Greg Creech, P. O. Box 

1431, Pine Lake, GA  30072-1431, www.gregcreech.com. 

http://www.gregcreech.com/
http://www.gregcreech.com/
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Introducing Greg Creech 

Shop Talk from The Atlanta Journal-Constitution 
Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job – Greg Creech 
What I Do: I teach technology courses and make presentations to beginner and expert computer 

users and professionals.  I use humor and the piano.  I train all levels from first-time computer users to 

systems technicians acquiring A+ certification.  As an A+ certified trainer, MOUS expert, and technical 

trainer, my certifications and knowledge give me a career 

in the technology.  My humor, the piano, and people keep 

me in the technology training field. I sing to my students 

sometimes and perform stand-up comedy about 

computers. 

How I got started:  I won Best Actor in a Supporting 

Role at Southside Theatre Guild for “A Funny Thing 

Happened on the Way to the Forum” and studied comedy 

under Jerry Farber.  I have played the piano since 8 years 

of age and had the first personal computer with a 1 MB of 

memory.  In order to learn the PC, I associated the PC 

with the piano  -- both use a language to translate, both 

have keyboards, and now - both provide music and 

information.  I must admit I miss the days when I only 

played the piano and programmed the PC.  Now, I play the 

PC and have to program my piano.  In 1998 after 

seventeen years of technology business experience in the 

corporate market, I decided to take a leap of faith on my 

own. I call my presentations “Showminars,” a 

combination of a show and a seminar. 

The Best Part:  Hearing the laughter and the comments:  

“You have saved me so much time,” and “I remember complicated macros 

because of the way you taught them.” I have a passion for teaching creative 

people to be more technical and technical people to be more creative – 

Mozart would be proud! 

The Challenging Part:  Explaining why I want my piano in a PC classroom.  

“Mainframers” who refuse to acknowledge the existence of the PC and the 

Web.  People who attend training classes because they have to, not because 

they want to.  Technical people who are not client- focused. 

My Favorite Quotes:  “To err is human, to really mess things up you need a 

computer.”  “Forty-two percent of all households have a computer; only 

eight percent of those know how to use it.”  

What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a 

unique speaking and learning experience. 

Technology  

speaker and  

trainer Plus, 

he’s a   

pianist and 

comedian. 
 

Greg Creech sings 
to his students, 
and often he 
performs stand-up 
comedy about 
computers. 
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Welcome! To Excel 

Let’s look at Excel’s main window and components of the interface. 

1. Open Excel. Excel will present a blank Worksheet ready for you to 

begin or Excel may provide a screen for you to use templates or open 

other files, as displayed below for you.  In any event, create a new 

blank workbook by clicking the Blank workbook item. 

2. Pictured below is the Worksheet Window for Excel 2013. 

3. Let’s take a tour of your Worksheet Window. 

  



Greg Creech Excelling at Excel  Page 7 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Wo rk sh ee t  Win do w  

 

The top area of your screen is the Quick Access Toolbar with the Title Bar. The File Tab which 

is the first tab in the Office 2013 Ribbon allows you to print, save, and perform other file  

functions; we’ll learn much more about this including using the Excel Options button. Next in 

this area of your worksheet is the Quick Access Toolbar which allows you to quickly access 

your favorite commands and you may add and delete commands from this toolbar.  We’ll learn 

how to customize the toolbar and other options for using this productive tool in Excel.  The Title 

Bar displays your Excel File or Workbook Name and contains the Help, Ribbon Display 

Options, Minimize, Restore/Maximize, and Close commands. 

  

1. The File Tab, Quick Access Toolbar and 

Title Bar. 2. The Ribbon with Tabs, 

Groups, and Commands. 

3. Name Box and Formula Bar. 

4. Worksheet area with Column 

Headers (the Alphabet) and Row 

Headers (the Numbers). The 

intersection of columns and rows 

create cells and the Excel grid. 

5. Navigation buttons and 

Worksheet tabs. 
6. Status Bar, View Buttons, and 

Scrolling Zoom. 
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 The next area as pictured above is The Ribbon. The Ribbon contains three areas – The Tabs, 

The Commands, and The Groups with the Dialogue Box launcher. We will use the Ribbon 

extensively in all aspects of Excel from formatting to creating formulas and functions.   

1. Let’s open a sample workbook to use in our 

demonstration. 

2. Click the File Tab. 

3. From the Cascading Menu, Click Open.  

4. Navigate to where your files are stored for this 

course. 

5. With the Budget.xlsx file selected, Click Open OR 

Double Click the Budget.xlsx icon to open the file 

in Excel. 

6. If you are prompted to Enable Macros, please click Enable Macros.  

Our workbook opens.  We should have two workbooks open a blank workbook and the 

Budget.xlsx workbook. 

 If you don’t have two workbooks open then follow these steps.  

1. Click the File Tab and Click New or use the Keyboard Shortcut CTRL + 

N (Pressing the Control key and the “N” keys simultaneously) for a new 

Workbook. 

2. From the New Workbook screen click the Blank Workbook item and 

then click the Create button at the lower right of your screen.   

We can “toggle” or move between the two files using our View Tab on the Ribbon and Clicking 

the Switch Windows command button. Let’s try this.  

1. Click the View Tab and click the Switch Window, 

Groups 

Tabs 

Command 
Buttons/Icons 
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2. Click the File that is not active, for example my Book1 as 

displayed here and the file activates.  

3. If your View tab is still active (or if not then click it to 

activate it again), and then click your Budget workbook to 

activate it. 

 

Below the Ribbon and Groups are the Name Box and Formula Bar. The Name box indicates 

your position and selected cell in the worksheet and 

allows you to give selected cells an English name or 

code which we learn later in our course.  This allows 

you to quickly move to this area of your worksheet and to calculate formulas using names.  

 

The Formula Bar illustrates the contents of your cell whether numeric or alpha text.  You edit 

your functions and formulas in this box.  Formula and functions begin with an equal sign (=), 

we’ll learn a lot more about this in the Formula and Functions part of our course. Cell A1 in 

this worksheet uses the =TODAY() function. 

A Hot Tip! Select All Button:  There is a magic box in 

the upper left part of your worksheet (bounded by the 

Column header A and Row header 1).  This magic box 

selects the entire worksheet with one click of this button; 

this is the Select All Button. If you are not clicked in the table 

of data, you may select the entire worksheet by pressing the 

CTRL + A keys together; if your cursor and selection is in the 

table of budget and expense figures CTRL + A keys selects 

the data table not the worksheet. This is a terrific way of 

selecting a table or database in Excel using CTRL + A key 

rather than selecting a big area of the worksheet through 

Click and Drag or other methods of selection that we will 

learn. 

 

Column Headers are the Alpha characters beginning the column.  You may click on a Column 

Header and the entire column selects or highlights.  You may click on a column header and drag 
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to the desired column to select multiple continuous columns.  You may select columns that are 

not continuous by left clicking, pressing the CTRL keyboard button, and then left clicking the 

desired columns; when complete release you CTRL key and mouse button and Viola your 

columns are selected.  You may use this method to select various cells and rows, as well, that are 

NOT continuous.  

 

 A Hot Tip!  In this document when we want to select cells 

and areas that are not contiguous I will use the term Ctrl + 

Click to indicate using the Ctrl key and click method of 

selection.  When we want to select areas that are contiguous 

I will use the term Shift + Click or we may also use Click and 

Drag to select continuous areas of our worksheets.   

 

Row Headers are the Numeric characters or numbers at the beginning of the row and operate in 

the same fashion as Column Headers. 

A Cell is the intersection of a column and row.  Cells are signified by the column letter and row 

number position, such as Cell C4 is the intersection of Column C and Row 4 or G10 is column 

G, Row 10 (BINGO! Ha, ha!)  You may select multiple cells by left clicking on a cell and 

dragging to the area that you desire and release your left click button. 

Let’s practice selecting continuous and non-continuous columns and hiding and unhiding 

them. 

1. With your Budget Workbook open and your 

January tab active, click column header C. 

2. Press your Shift Key and Click the column 

header G. Columns C through G highlight for 

you.  

 A Hot Tip: You may get the small dark 

arrow to select your column header and 

click and drag to select your continuous columns, too.   
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3. With these columns selected, right click on one of the letters 

and from the shortcut menu click Hide and the columns 

disappear. 

 

Let’s unhide them and the hide columns that are not continuous. 

4. Click the Select All button at the top of your workspace area 

to select the entire workbook. 

5. Right click on a column header and from the menu click 

unhide. 

6. Now, Click column header C and press the CTRL (or Control) 

Key and keep it pressed as you click other columns. 

7. With your CTRL key pressed, click column header F and column 

header H.  These columns select for you as you click them with 

the CTRL key pressed. 

8. Now, right click one of your selected column headers and from 

the short cut menu choose hide. 

9. These non-continuous columns hide for you. 

10. Let’s unhide them. Click the Select All button at the top of 

your workspace area to select the entire workbook. Right click 

on a column headers and from the menu click unhide. 

Notes: 

  If you want to unhide a specific column but keep the others hidden for example if I want to 

unhide Column C but keep the other columns hidden, I can select Columns B through D with 

Column C hidden and right click on the two selected column headers and from the shortcut menu 

choose unhide and only Column C is unhidden. 

 If you click inside of the Budget and Expenses and press CTRL + A only the table of data 

selects not the entire worksheet.  You may use the Select All button to select the entire worksheet 

or CTRL + A to only select a table or database in Excel. 
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Worksheet area is the area surrounded by the column and row headers and is your primary work 

space in a worksheet. 

Worksheet Navigation Buttons and Worksheet Tabs: The Navigation 

Buttons at the lower left of your workspace area scroll to various worksheets 

within your workbook in order for you to select the worksheet in which you 

desire to work.  A description from left to right by clicking the appropriate 

button is:  

Button 1: The small left arrow scrolls through the worksheets to the left. 

Notice the shortcut menu if you hover on the left arrow as displayed here. 

CTRL + Left clicking this arrow will display the first worksheet. Right 

clicking this area displays all sheets as described in the Hot Tip below.  

Button 2: The small right arrow scrolls through the worksheets to the right 

and CTRL + Left clicking this arrow will display the last worksheet for you.   

 

A Hot Tip!  If you have multiple worksheets as 

the Budget file does, you can quickly go to a 
specific sheet by right clicking on the navigation 
buttons to get a shortcut menu and then left 
clicking the sheet you desire.  In the picture at 
right my January sheet is active and all of the 
sheets are displayed.  If I wanted to go to the 
October sheet, I could click it and that sheet would 
activate.  Worksheet tabs names your worksheet 
and become active upon clicking on the tab.  If you 
have a lot of worksheets Excel displays “More 
Sheets. . . “ at the bottom of this dialogue box for 
you to open another box allowing you to vertically 
scroll through and activate your desired worksheet. 

 

The Status Bar displays information about your worksheet and cells, 

displays whether your Number Lock and Caps Locks are activated, whether you are recording a 

macro, and has a nifty Calculation box that we will use later. 

You can navigate in your worksheets and through your worksheets through several keyboard 

shortcuts, too, and select data in a column or row quickly.   
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Keyboard Shortcut What it Does 

CTRL + Home Takes you to the top of your worksheet, 

usually cell A1. 

CTRL + End Take you to the end of your worksheet. 

PgUp (Page Up) and PgDn (Page Down) Takes you down or up several rows 

(screen pages) at each press of the key. 

CTRL + PgUp (Page Up) and CTRL+PgDn 

(Page Down) 

Scrolls through your worksheets or tabs.  

CTRL+PgUp Scrolls to the Left for you 

and CTRL+PgDn scrolls to the Right. 

CTRL + Shift + Down/Up Arrow Selects an entire column of 

data/information based on the cell that is 

selected. 

CTL + Shift + Left/Right Arrow Selects an entire row of data/information 

based on the cell that is selected. 

CTL + Shift + Home Selects from your active/selected cell to 

the top of your worksheet.  

CTL + Shift + End Selects from your active/selected cell to 

the bottom of your worksheet. 

 

With your Budget file open, use these navigation techniques to navigate 

around your worksheets and open the Track workbook and select a column 

and row data using the CTRL + Shift and arrow keys. You may use the Shift 

key and arrow keys to select individual row or columns and with the Shift key 

pressed, press the Page Up (PgUp) or Page Down (PgDn) to select a larger 

area of your worksheet. 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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Imp or tan t  T ip s  to  mak e  yo u r  Exce l  

Exp er i en ce  Eas i e r  

Resizing columns and rows 

If you position your cursor between a column and row header, a double-headed arrow will 

appear as your cursor.  Click and drag to resize your column or row.  You should place your 

cursor to the right of the column you want expanded and below the row you want increased.  For 

example, to change the width of column C move your cursor between column headers C and D 

to get the double headed arrow to resize your width.  To change the height of row 7 you would 

move your cursor between row 7 and 8 to get the double headed arrow to 

change the height of row 7.  You may right click on a column or row header 

and from the Shortcut menu choose Column Width or Row Height and the 

screen at right appears for you to type in a number for the width/height of 

your column/row. 

 A Hot Tip! If you double click your double headed 

arrow cursor, the row or column will automatically adjust to 

fit the information in the column or row.  Pound symbols or 

hash marks (#######) will appear in column cells that are 

not large enough for you to view the data.  The pound 

symbols or hash marks in a cell have “freaked out” many a 

new user to Excel, including me.  I felt like I had done 

something terribly wrong.  Simply resize your column width 

so the data in the column will fit.  

Rename a Worksheet 

To rename a worksheet, double click the worksheet tab at the bottom of the screen.  For 

example, to rename Sheet 1 double click the Sheet 1 tab, the tab is highlighted, and type a new 

name and press enter.  Also, you may right click on the Sheet Tab for a short cut menu to 

Rename the worksheet.  As well as Renaming your worksheet, Right clicking on the tab allows 

you to insert, delete, or move/copy your worksheet.  This is a great tool and short cut that we 

will be using throughout this course.  
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 Notes: Worksheet names should not contain special characters, such as /, 

?, or [] and you may not use the same name twice in a workbook.  You are 

limited to 31 characters for a name.   

 

A Hot  T ip !  Status Bar and 
Calculations 

The Status Bar in Excel has many options from which to 

choose.  I like having the Sum, Count, Average, and other 

functions on my Status bar.  You may right click on your 

status bar and receive the Customize Status Bar Pane as 

pictured at right.  I have activated all of my options as I learn 

Excel. 

This doesn’t affect your worksheet, but does provide the 

result of the functions based upon your selected range of 

cells.  This is another excellent and quick tool for 

summarizing, averaging, etc. cells and information that are 

continuous or not.  Let’s try it out 

1. In the January Tab of your Budget 

worksheet, Click and Drag cells B5 

through B14 to select them. 

2. The Sum, Average, Count and other 

functions of the cells should appear 

based on your selection in the Customize 

Status Bar pane.  

A Hot Tip!  Another neat trick is to use the CTRL + Click method to select 

cells that are not continuous, such as B5, B7, B9, the Calculations will provide 
the SUM ( or other selected function) for the cells selected. This provides 
quick calculations for cells that are not continuous and prevents you from 

creating a formula or pulling out the good-old calculator.  
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1. Let’s select non-contiguous cells and see the results. 

2. Click Cell B5. 

3. Press your CTRL key and keep it pressed as you click the following 

cells:  C7, C8, C10, C11, and B16. 

4. Notice that as you click your cells your calculations change.   

5. You can click away from the area to deselect your changes. 

 An Important Gotcha! If you accidentally click the wrong cell or do not want a 

previously selected cell in the calculation, you cannot CTRL + Click the cell again to 

deselect it as you can in other applications and areas of Excel.  You’ll have to start from the 

beginning of selecting your cells using the CTRL + Click method again.   

 

There are important items at the end of your Status bar.  The View command buttons for 

Normal, Page Layout, and Page Break 

Preview are here for you and the 

Scrolling Zoom. 

We’ll look at these views later. 

Click the Zoom selector arrow and click and drag in out to see how Excel 

changes your view of your worksheet. A keyboard shortcut is to press your 

Control (CTRL) key and use your mouse’s wheel (if you have one) to zoom in 

or out depending on the direction you are rolling your mouse wheel. 

 

 

 A Hot Tip! The ESC (Escape) key: Another handy key on 

your keyboard is the Esc (or the Escape) key.   When doubt, 

press this a couple of times to clear your formula, selected 

cells, and other times when you feel you are making a mess 

or Excel won’t let you move or navigate because you have not 

completed a function.  The Escape key will help alleviate 

trouble, but may not prevent bad formulas and formatting.   
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Customizing Excel  for Productivity  
 

Q u ick  Acces s  Too lba r  Op t ion s  and  

Cu s tomiza t io n   

As we begin using Excel, we need to learn the Quick Access Toolbar and how to add command 

buttons to it.  We’ll examine the Ribbon and other new interface techniques as well as using old 

(even ancient) keyboard commands that have been around since DOS and new keyboard 

commands called Key Tips that were new to Office 2007/2010. Adding your own command 

buttons to the Quick Access Toolbar ensures the command button is always available for you 

since your command buttons change based on which Tab you have active.  

New with Office 2010 and continues with Office 2013 is the ability to customize the Ribbon 

and create your tab as well as to enable and disable tabs.  We will accomplish this in your next 

section. 

 

 Important Gotcha! When your Excel Options menu is open and active nothing in Excel 

is operable and all tabs and groups are disabled.   

 

Let’s look at the Customize Options for our Quick Access Toolbar.  

1. The Quick Access Toolbar is the only toolbar in 

Office 2013 and is located at the top area of 

your screen in the Title Bar area.  

2. In a blank Worksheet or the Budget workbook, 

click the Arrow at the end of your Quick Access 

Toolbar to list the Customize Quick Access 

Toolbar command buttons and options. 

3. You may quickly add command buttons to your 

toolbar by clicking them in this window to add 

them to your toolbar – the check mark 

represents a command button already on your 

toolbar. 
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4. The cascading menu closes after you check an item to add, such as 

New, Open. I wish the menu could remain open as you check these 

command buttons.  Check all of the buttons to add these to your 

Quick Access Toolbar. 

After adding these buttons, we will further customize the Quick Access Toolbar with some of 

my favorite and popular commands in Excel.  We will use the More Commands from your 

Customize Quick Access Toolbar Pane.  

We are using the More Commands button and Excel option screen for three reasons: 

1. You may rearrange and move your buttons as you like, 

2. You may add more than one button at a time, 

3. You may add buttons that do not exist in the Ribbon or Tabs. 

Let’s add rearrange our buttons and add some neat and helpful commands so we may quickly 

use some of Excel best commands. 

 

1. At the end of your Quick Access Toolbar click the arrow and then click 

the More Commands. . . item in this menu. 

2. The Excel Options Pane opens at the Customize screen ready for you 

to select commands and add them to your toolbar. First let’s move 

some of the commands we have already added.  
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3. Click the New command button and using the Up arrow click to move 

the command button to the top as displayed above. Next move the 

Open and the Open Recent File… below the New button. Rearrange 

your buttons to fit your needs. 

Now, let’s add buttons to our Quick Access Toolbar. You may add buttons by selecting the 

command you want on the left part of the pane and double clicking the button or clicking the 

Add button in the Center of the Pane.   

 Hot Tip! You may add your button to your Quick Access 

toolbar in the position you want by selecting the Quick Access 

Command, such as Sort Descending and the double clicking 
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or clicking the Add button and the Custom Sort button is 

beneath your Sort Ascending and Descending buttons. Excel 

places the new command button below where your selection 

is on the right part of your pane.   

1. I have added some of my favorite command buttons from the Popular 

Commands section.  As you use Excel you will find command buttons 

that you will want always available for you. Using the Popular 

Commands item in the Choose commands from: box.  Here are some of 

my favorite commands to add to and rearrange on my Quick Access 

Toolbar using the Popular commands item: 

✓ Save as 
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✓ Custom Sort 

✓ Cut, 

✓ Copy, 

✓ Paste 

✓ Paste Special 

✓ Insert Sheet Rows 

✓ Insert Sheet Columns 

✓ Set Print Area 

✓ Freeze Panes 

✓ Page Setup 

✓ Paste Special  

✓ Insert PivotTable 

✓ AutoFilter 

✓ Speak 

Add your popular commands and rearrange them on the Quick Access 

toolbar by selecting a command and using the Up and Down arrows to 

move your buttons. 

 

The Drop Down box (circled below) at the top of the customize screen allows you to choose 

other Tabs or All Commands in order to 

add other command buttons to your 

toolbar; this is the Choose commands 

from box.  The second box at the right 

allows you to use the custom Quick Access 

Toolbar in all workbooks or only the current 

workbook. We want this for all of our 

workbooks. 

1. Next change your Choose 

commands from box to All 

Commands as circled above. 

Click in your list of commands 

to select a command and press 

the letter A and scroll to 

AutoFilter.  Pressing the letter 
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on the keyboard and keeping the letter pressed, Excel will scroll 

through all of the commands associated with the first letter. Add 

AutoFilter to your Quick Access Toolbar this command button doesn’t 

appear on the Ribbon and is very helpful.  This one button 

accomplished two tasks – first it will filter for whatever you have 

selected and it will turn on your filtering for you.  I also add the Clear 

Filter button.  Notice ALL of the Commands in Excel and add your 

buttons as you wish.  

2. Next, click back in the All Commands list and press the letter C on your 

keyboard. Excel jumps to the C for you to scroll down or continue 

pressing the letter C on your keyboard to find the Clear button. You 

want the Clear button with the Funnel or Filter. 

3. Next, decide if you want to show the Quick Access Toolbar above or 

below the Ribbon. Since I use so many commands on my Quick Access 

Toolbar which crowds my Title bar, I like having my Quick Access 

Toolbar below the Ribbon so I have checked the box. 

4. Click OK. 

 

A Hot Tip!  The Reset button will restore 

your Quick Access Toolbar back to the 

Factory Standard with no customization.  

Pressing the Reset buttons offers you to 

Reset only the Quick Acces Toolbar or All Customizations.  

The Dialogue box below appears when you click the Reset 
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button.  I sure do not want to click yes, since we will use our 

Quick Access Toolbar throughout the course.   

 

 There is a quicker and easier way to add buttons to your Quick Access Toolbar and 

here’s the HOT TIP for you. 

 

 A Hot Tip:  You may add any command button to the Quick 

Access Toolbar by right clicking the 

command button and from the menu 

choose add to Quick Access Toolbar.  I 

have right clicked my Merge & Center 

command button on my Home Tab and the 

menu at right displays for me to click the 

Add to Quick Access Toolbar item and 

Excel places the command button on the toolbar for me.  

Using this method places the button at the end of your 

toolbar, unfortunately you must use the Customize Quick 

Access Toolbar pane in Excel Options to rearrange the 

commands position as we accomplished earlier.  

 

 Write your notes here:_________________________________________________________ 
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Tab s  a nd  Th e  R ibb on  S ho r t cu t s  

As we begin our study of the tabs and groups, here are a couple of important and time saving 

Hot Tips for you in using the Ribbon and Tabs! 

 Hot Tip 1:  Minimize the Ribbon! Four ways to minimize the Ribbon – First, the 

Ribbon takes up a lot of space on your screen. You may minimize the Ribbon and 

use it only when you click on a Tab.  

1. Office 2013 has the Minimize Ribbon arrow at the top of your 

window next to the Help button.  The Minimize the Ribbon button 

appears at right. With the Ribbon minimized the button becomes 

the Expand the Ribbon button.  

2. To minimize the ribbon double click the active Tab’s Name. 

Double clicking a tab expands/minimizes the ribbon, too, or as the short cut menu 

suggests use the Keyboard shortcut of F1 described next. 

3. Keyboard shortcut of CTRL + F1 – when you press your CTRL (Control) and the 

F1 keys simultaneously on your keyboard the Office application minimizes and 

expands your Ribbon, too. 

4. Right click on any tab or command button on the 

Ribbon and from the short cut menu choose Collapse 

the Ribbon at the bottom of the menu.  

Why minimize The Ribbon?  The Ribbon takes a lot of space. With 

the Ribbon minimized you have more room in which to work on your file.  With the Ribbon 

minimized, to use a tab, you click the tab and the Ribbon’s tab expands for you to use the Command 

Buttons.  After clicking the button you want and you click back into the body of your document, 

worksheet, or presentation the Ribbon minimizes again. This is similar to using the old Menu bar.  

The difference is the Menu bar was vertical and text oriented and the Ribbon is horizontal and more 

graphically oriented.  

 Hot Tip 2: Second, if you have a scroll wheel/button on your mouse and 

the Ribbon is NOT minimized, you may scroll through the different tabs 
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rather than clicking the tab.  Moving your cursor to the  Ribbon and rolling 

your scrolling button/wheel up or down changes the tabs for you! You must 

first click on a tab for this to work; otherwise, the application will scroll 

through your file – not the Ribbon.   

 An Important Gotcha! With the Ribbon minimized you cannot scroll through the Tabs as 

described above.  You’ll have to maximize the ribbon in order to scroll through your tabs 

and command items.  

Try these two shortcuts, I think you’ll like using these two features in Office 2013. 

Excel’s interface includes the Ribbon which contains tabs as we have studied and within the tabs 

there are groups such as the Clipboard group, Font Group, and Alignment Group as displayed 

at right.  At the bottom of some groups you will notice an arrow, as 

circled above, this arrow is the Dialogue Box Launcher which offers 

more options for you.  Activating a Dialogue box from this group 

opens the Dialogue box tab for that group.  When I clicked the Font 

Dialogue box launcher, the Format Cells Dialogue box opens at the 

Font Tab. 

We will use many of these tabs, groups, panes, and dialogue boxes 

throughout this book.  We’ll start with the Home Tab and Formatting 

options, including the Mini Toolbar, after we look at some of the 

Keyboard shortcuts and Key Tips. 
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 Hot Tip! You may add a Dialogue box to your 

Quick Access Toolbar by right clicking the 

Dialogue Launcher Arrow and from the menu 

choosing Add to Quick Access toolbar just as we 

accomplished with the Merge and Center 

button.  As displayed here I am adding my Font  

format cells dialogue box to my Quick Access Toolbar.   
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Keyboa rd  Sh or t cu t s  a nd  Key  T ips  

Here’s a nifty table of my favorite Office, including Excel, shortcut keys. 

My Favorite Keyboard Shortcuts  

Keyboard 

shortcut 

Command Keyboard 

shortcut 

Command 

CTRL + A Select All CTRL + T Excel Create Table 

CTRL + B Bold CTRL + U Underline 

CTRL + C Copy CTRL + V Paste  

CTRL + D Excel – Fill Down – Duplicate 

PowerPoint – Duplicate 

Word – Font Dialogue Box 

Outlook - Delete 

CTRL + W Close – Closes the Workbook in Excel,  

CTRL + E Word and PowerPoint Center 

Alignment – Paragraph 

Excel – Unassigned /Doesn’t work 

CTRL + X Cut 

CTRL  +  F Find CTRL + Y Repeat Last Action 

CTRL  + G Go To CTRL + Z Undo 

CTRL + H Replace ESC This key cancels the current command 

or operation. 

CTRL + I Italic CTRL + Home Top 

CTRL + J Word and PowerPoint Justify 

Alignment – Paragraph 

Excel- Unassigned/Doesn’t work 

CTRL + End End/Bottom 

CTRL + K Insert Hyperlink F1 Help 

CTRL + L Word and PowerPoint Left 

Alignment – Paragraph 

Excel-Unassigned/Doesn’t work 

F5 Go To 

CTRL + N New F7 Spell Check 

CTRL + O Open F10 Key Tips (Office 2007 only) 

CTRL + P Print F12 Save As 

CTRL + R Right Align Using a scrolling wheel on your mouse, you may 

press your CTRL (Control Key) and with it 

pressed, roll your scrolling wheel up to increase CTRL + S Save 
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CTRL + S Save CTRL  + 

Mouse 

Wheel 

the size of your document, worksheet, etc. and 

roll the wheel down to decrease the size. This is 

the keyboard shortcut for the zoom feature. 

There are other keyboard shortcuts, too.  You can use the help system in Excel for a list of all 

keyboard shortcuts that perform a variety of operations for you, just type Keyboard Shortcuts in 

the Help Search Box.   

Now, in the Office Suite are keyboard shortcuts called Key Tips.  To activate your Key Tips, 

press the ALT or F10 key on your keyboard.  Excel displays screen tips or Microsoft calls these 

badges pictured here.  To activate 

a Tab press the corresponding 

badge key, for example press H to 

activate the Home Tab and the 

badges for this tab’s commands.  

Let’s try this in Excel 2013. 

1. Open Budget workbook. 

2. Press your Alt key to activate your Key Tips or you may press the 

Function 10 (F10) key on your keyboard to display the Key Tips.  

3. Press your P key on your keyboard.  Notice that Excel places you are 

the Page Layout 

tab and Key Tips on 

all of your 

commands on the 

Page Layout Tab 

appear. 

4. Press the O key to 

activate your 

Portrait or 

Landscape 

Orientation. 

5. Press the Down Arrow key on your keyboard to Select Landscape and 

press enter to activate the selection. Your worksheet is now 

Landscape. 
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6. Let’s return this to Portrait by pressing your ALT or F10 key, Pressing P 

for Page Layout, Press O for Orientation, and since Portrait is selected, 

press enter and the worksheet returns to Portrait Orientation for you. 

 

Why Key Tips? Many people still do not like using the mouse (YET) and prefer only using the 

keyboard; using key tips you never have to use the mouse for commands in the Ribbon or 

Quick Access Toolbar.  Also, this aids people with Carpal Tunnel Syndrome.  
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The Functions Keys and combination keys such as Shift and a Function key are still around, 

too.   Here are some of the Function Keys from Excel.  

Function 
Key 

Command 

F1 Excel Help. 

F2 Edits the active cell and positions the cursor/insertion point at the end of the cell’s 

contents. 

F3 Paste Name Dialogue box appears 

F4 Repeats the last command or action. Also, if you click in your formula bar at a cell, the 

F4 key will toggle through your various references that we will learn, such as relative 

or absolute. 

F5 Go To Dialogue box activates. 

F6 Switches between the worksheet, ribbon, panes, and other areas of your worksheet. 

F7 Activates Spell Check. 

F8 Extend your selection (or increases your highlighted areas.) Press the F8 key and then 

use your arrow keys or other keys to select cells, rows, and/or columns for you. 

F9 Calculates all open worksheets. 

F10 Show Key Tips. 

F11 Creates a chart from the selected range. 

F12 Activates Save As Dialogue box. 

Activate the Help box by pressing the F1 key on your keyboard.  Type in Function keys or 

keyboard shortcuts and Excel will list a lot of shortcuts for you.  I encourage you to review these 
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and find your favorite shortcuts as you use Excel. We will use many of these shortcuts and items 

throughout our course. 

Format Painter 

We will use the Format Painter throughout this course.  Let’s format Cell A5 and then use the 

Format Painter to copy this formatting to the other cells. 

 

The Format Painter icon:  This time saving button is in the Home Tab’s 

Clipboard group or in the Mini Toolbar. Format Painter button allows 

you to apply formats from selected cells to other cells.  Select the formatted cells, click the 

Format Painter icon, and select the cells that you want to apply the formats.   

 One click on the command button allows you to “paint” or 

copy over once on the cells.   

Double clicking the Format Painter keeps the Format Painter 

active and allows you to “paint” or copy your formatting over 

multiple cells or areas; you must re-click the Format Painter 

icon or press the Esc key to deactivate the painting function.  

 

This only copies the formats nothing else, BUT you formats can be quite extensive. 

1. In your Budget workbook, Click Cell A5 which should have the word 

Lease in it. 

2. Click the Cell Styles Icon and from your Style Pane choose a style 

from the Themed Cell Styles area. I’m choosing Accent1.  
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Format as A Table  

Excel has a terrific way of formatting your database as a 

table with built in color schemes and functionality for 

you.  However, there are gotcha’s which I will share with 

you, that is why we will make a copy of your database 

sheet first and then use the Format as Table command 

button and Design tab. 

1. Open the Track.xlsm workbook, 

2. Make a copy of the Jan worksheet, 

3. Click in the database area, such as cell C10 in the 

Customer column. 

4. On the Home Tab click the Format as Table button and 

from the gallery choose a style for your table.   You can 

always choose another style. 

5. After you choose a style 

Excel will ask you the data 

range as displayed here.  In 

this case Excel guessed 

correctly and My table does 

have headers, ie Date, 

Order, Customer fields. 

6. Click OK. 

The Format as Table command button and 

gallery accomplish more than colors and 

shading, notice that your filter arrows are 

on and ready to use and Excel activates 

the Design tab for you.  
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 A Hot Tip! With your database formatted as a table scroll 

down in your database table and notice that Excel changes 

the column headers from A, B, C, to your field names, as 

pictured below. So you don’t need freeze panes in this 

example.   

Now the gotcha’s. 

 Very Important Gotcha’s with Format as  Table: With your database formatted as a 

table, you cannot use SubTotals or Custom Views.  You cannot share your workbook if you 

use Format as a Table, too. Click your Data tab and your View tab and you will notice 

these items and others grayed out.   You may remove format as a table by clicking the 

Convert to Range button on the Design Tab of your table tools. The Error Message below 

appears when you try to share a workbook using the Review Tab and the workbook 

contains Format as Table. I’m not a programmer so I’m not sure why Excel disables these 

features for such terrific functionality.  
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Data Manipulation: Fi lters and Sorts  

Our final F is Filters and Sorts.  We will learn Filters and Sorts using our Track.xlsm 

workbook file.  This workbook has an extension of xlsm in order for us to accomplish Macros in 

this workbook.  The m in in xlsm is for a macro enabled workbook which we will learn later.  

Quickly here are what filters and sorts are: 

✓ Filters provide a quick way of viewing certain information and can include criteria for 

displaying your information. 

✓ Sorts allow you to order your data in various ways. 

Filter is a great way to view information or data based upon criteria and selecting items from a 

drop down list or pick list.  We will use several different types of Filters such as Text, Top 10 

and Custom as well as using the powerful and easy drop down list items. 

Here are the ways to access Filter and Sort: 

✓ The Home Tab the Editing Group contain Filter and Sort Commands, 

✓ The Data Tab includes a Sort & Filter Group, 

✓ Use Command Buttons on your Quick Access Toolbar or your Custom Tab on the 

Ribbon, 

✓ Right clicking and the Filter and Sort items are included in the Short Cut Menu. 

We’ll use all these ways to Filter and to Sort. 

1. First, let’s open the Track.xlsm workbook,  

2. Click the Jan tab. 

Excel Database 

This workbook and worksheets contain a database or data table of information that begins with 

the Header Row (or Field Names) of Order, Date, Customer, etc.  The top area of the worksheet 

is for summary information and titles.  Excel works very differently when used as a database or 

table like this list of customers.  This is a tracking system or database of information about our 

customer sales and orders.  With your information organized in this fashion Excel works great 

with items such as sorting, filtering, sub-totals, Pivot Tables, and other items we will examine.  

An Excel database contains a row called Column Headings, I like to think of this as our field 

names for our “simple” database, all rows beneath this row contain only data or a calculation, 

but not sub-totals or blank rows.   
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 An Important Gotcha Your Excel table or database should not contain blank rows or 

columns; you may have blank cells but not blank rows or columns.  Excel considers a blank 

row or column to be the end of your database or table.  

1. Click the Income Tab in the Track.xlsm file. 

This worksheet is not a database and is not good with filtering and sorting.  This worksheet is a 

typical type of Excel worksheet with items being totaled and sub-totaled in rows and columns.  

You could Sort a specific area, such as A7 – G11, but not a column or other area.  Filtering 

would not be useful in this type of worksheet, either. 

Filter through A List  

 You should be in your data or table area and near your header row in order for Excel to 

know how to and what to filter. Otherwise, Excel will give you an error that it could not find a 

list; therefore, be in your list area.  

Let’s get ready to Filter our database or table in many neat ways. 

1. In your Track workbook, 

2. Click the JAN worksheet 

3. Click cell C8. – the first cell under your Customer Field name or column 

heading.  

4. Scroll to find Computer Tech and select a cell with Computer Tech. 

5. Click the AutoFilter button that we added to our Quick Access Toolbar. 

Quickly AND easily Excel displays only the orders for Computer Tech. 

The AutoFilter will filter for whatever you have selected and turn on 
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your Filter (the arrows next to your field names or column headings) as 

displayed above.  

Without using the AutoFilter button here is how to Filter for Computer 

Tech (or any other client). 

1. On Home Tab,  

2. Click the Sort & Filter command button,  

3. Trace to Filter and Click it. 

As pictured, small drop down arrows appear in your column headers or 

fields.  

1. In the Customer header, 

2. Click the Drop Down arrow, 

3. A Menu of your Customer Names appears.   

4. Click the Select All check mark item to deselect all 

of your items, next Click the Computer Tech box , 

5. Click OK,  

6. Excel Displays only Computer Tech..   

Filters will display only certain information for you.  The data is not 

deleted and when we remove the filter all rows will display again.  

1. Notice the Drop Down arrow has turned to a Filter 

icon this indicates that a filter is on for this field 

and when a screen tip appears alerting you to the 

criteria for this filter. 

2. Click the Drop Down arrow, 

3. To view all of your data again without turning off 

the Filter, Click the Select All box – You may need 

to scroll up to see the All selection. 

4. Click OK and All of your customers and their 

data appear again. 

5. Click the Sort & Filter button and from the menu 

click the Filter item to turn off your filter. 
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6. Notice that when you have your data filtered, the Sort & 

Filter button on the Home Tab activates Clear and Reapply 

for you. You may remove your filter by clicking the Clear 

button and then you are ready for additional filters. You 

may use the Clear button we added to your Quick Access 

Toolbar, too.  

 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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If you prefer, you could use the Data Tab to Filter, too. 

1. Click in your Customer list on the Jan 

tab, 

2. Click Data Tab and Click the Filter Button 

in the Sort & Filter Group,  

3. Excel activates the Drop Down arrows 

for your Column headers or Field Names. 

4. Click the Customer Arrow and Click the Select 

All box to deactivate your selections.   

5. Click a few customers whose data you would 

like to view. 

6. Click OK. 

7. To view all of your data 

again, click the Clear button 

in the Sort & Filter Group of 

the Data tab.  The Clear 

button becomes active when 

you have a filter on. 

8. Try several different selections for specific 

dates, amounts, and other filters based on your 

selections.   

 

 An Important Gotcha! Notice that you have two entries for ABC Co. Databases and data 

tables are very literal and must have consistency.  Databases and Data tables/list won’t 

make assumptions and spaces and periods count in names of items.  Excel has a terrific 

feature entitled AutoComplete. (This item is found under your Office Button and Excel 

Options and the Advanced section and the Editing Options has the AutoComplete enabled 

checked for you. We’ll look at these options later.)   If you begin typing a name that Excel 

can recognize from your list, Excel will display that for you to press enter to accept the 

entry automatically for you. For example, if you go to Cell C83 and type Com  - Excel will 

display Computer Tech for you to accept or to continue typing your own name.  Please use 

AutoComplete or be very consistent in your names and other items.  
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Multiple Fi lters 

Let’s filter the filter and then filter our filtered list! 

1. Have Track.xlsm  open and the Jan 

Worksheet is active. 

2. Have your Filter on.  

3. Click the Drop Down Arrow and from the 

cascading menu Click the Select All box to 

deselect everything.  Next, click the 

Computer Tech box to display on 

Computer Tech’s information,  

4. Next, Click the Drop Down arrow for Total 

and deselect all of the items and Click 

$200. 

5. Only Computer Tech totals for $200 appear.  We have 

two criteria, now, for our filter. 

6. Click the Drop Down arrow for Date and from the list 

choose January 20. 

7. You now only see one row that meets the criteria of 

Computer Tech, $200, and January 20, 2012.   With the 

date notice the ways you may filter by year, month, and 

date. 

 

 When you have multiple filters on you can remove 

specific filters easily through the drop down arrow on a 

field that is filtered.  The short cut menu at right appears – 

notice the Clear Filter From “Customer” – Excel would 

remove this filter but keep the other filters for you.  
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Top 10 

Excel’s Filter can make Top and Bottom number lists easy.  You can specify whether you want 

items or percentages.  While the name says 10, you can specify the number you wish.   For 

example, if wanted the top 12 revenue producing clients you could specify a total column to 

show only the top 12 items.  If multiple numbers meet the criteria or a tie, Excel will not stop at 

the number you specified.  For Example, if your top 12 list include 3 clients with the same billing 

in the 12th spot – Excel would display your top 14 instead of 12.  Excel won’t make the 

assumption about which client you would prefer to see given a tie. 

 

Let’s filter for our top 6 billing days for our orders.  

1. With Filter active on your Jan tab of the 

Track.xlsm workbook, 

2. Click the Drop down arrow for Total, 

3. Trace to the Number Filters item, 

4. Click the Top 10 item from the list, 

5. The Dialogue box at right appears, 

6. Ensure Top is displaying – you may also 

look at the Bottom or lowest items – in our 

case here we could look at the 6 lowest 

billing accounts (losers!) 

7. Next from the number area change the 10 

to a 6 using the spinner control or typing in 

6, 

8. Next keep the Items displayed as pictured above you may also Show 

by Percent, 

9. Click OK. 

Great! Now let’s sort the list From Largest to Smallest. 

1. Using the Filter Drop Down arrow for Total and 

clicking Sort Largest to Smallest – Excel sorts this 

for us from the greatest amount to the least 

amount.  
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2. Notice that your list has more 

than 6 – there are multiple $5,000 dollars at the 6th mark so the list is 

expanded.   

 

 Hot Tip! Filter information and AutoCalculate - Remember 

the Calculations in your status bar?  Select your list in the 

Total column and notice your Sum, Average, and Count 

functions in the status bar, if you have these items activated. 

Also, with a Filter active you should notice the information at 

the left of the status bar displaying 7 of 88 records 

illustrating the number of items that meet your filter criteria 

and are displayed. These items will aid in further analyzing 

your filter information.  

3. Remove your filter by clicking the Clear button on 

your Data Tab or Quick Access Toolbar.  

 

 Write your notes 

here:_________________________________________________________ 

 

________________________________________________________________________ 
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________________________________________________________________________ 

Custom Filters  

You can specify a range of items for the filter to apply.  You can have dates, numbers, and other 

items filtered with a range.  We will create a filter that will display our mid-range billing clients.  

Depending upon the type of data that exists in a column Excel provides different type of filters.  

We’ll look at different filters for different types of data such as Text, Numbers, and Dates. 

Number Custom Filters  

Let’s filter for a range using the Total column. 

1. The Track.xlsm file is open and Filter is 

Active, 

2. Click on the Drop Down Arrow for Total 

notice all of the number filters such as 

Great than and so on.  

3. Click Between. . . , 

4. The Custom AutoFilter dialogue box at 

right appears. 

5. Using the pictured dialogue box as a guide, 

ensure Excel provides is greater than or equal 

to  

6. then press Tab Key or Click the second box, 

7. Enter 250 or use the Pick list from the arrow 

to select 250. 

8. Ensure the And radio button is on. 

9. Press the Tab key or Click in the next box. 

10. Ensure “is less than or equal to” appears 

and Tab  to or click the next box, 

11. Enter 750 or use your Pick list by clicking 

the arrow, 

12. Click OK. 
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Your range of customers appears. 

Sort Descend this column using the sort descend icon on the Data Tab or the Filter Drop 

Down arrow for the Total Column. 

 

Text Custom Filter  

1. Let’s use Filter for Text characters. 

2. If there are any filters on your Jan tab, 

click the Clear button in the Data Tab or 

your on your Quick Access Toolbar to 

remove all filtered data. 

3. Click the Filter Drop Down Arrow for 

Customer. 

4. Trace to Text Filters and from the 

cascading menu, notice the different 

type of text criteria you may provide.  

5. Click the Custom Filter. . . item. 

6. The Custom AutoFilter Dialogue box 

opens.   

7. We want to view to different letters for 

our customer names.  We want all 

customer’s whose name begins with an 

A or contains oo.  

8. Using the picture at right as a guide 

make your choices and make sure you 

change the And selection to Or – the Or allows two different criteria 

for the same filter. 

9. Click OK. 

10. Only customer’s whose name begins with an A or have “oo”  

somewhere in the name appears. So, we have A.B.C. Co, Adam, Allen 

and Lucy Goosey, Shoot Pool, and so on.  Contains is a terrific filter 
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because no matter where the character resides in the name Excel 

displays the name. 

11. Click the Sort Ascending button on 

the Data Tab or using the Filter icon by 

Customer and from the menu selecting 

Sort A to Z as pictured at right. 

12. You may clear your filter from here or 

Click the Clear button on the Data Tab.  

Clear your filter. 

 

Date Custom Filters 

Excel has great built in Date Filters for you. 

1. With your Track.xlsm workbook open and 

at the Jan tab ensure you have no filters 

on your data but do have filter active. 

2. Click the Filter arrow for date and tract to 

Date Filters.  Notice ALL of the ways to 

filter your date lists. 

3. Click the Between. . . item and the 

Custom AutoFilter Dialogue Box  opens.  

4. Ensure that the Show rows where: Date 

item is set to is after or equal to and type 

or use the calendar pick list to enter 

01/12/2012 or use your Date Picker 

calendar. 

5. Keep the And  button selected. 

6. In the second set of boxes ensure Date 

item is set to is before or equal to and type 

or use the calendar icon to enter 

01/20/2012. 

7. Click OK. 
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8. Your data is filtered for that range of dates. 

9. Click your Filter arrow for Date and from the Menu 

Sort Oldest to Newest. 

10. Click your Clear icon on your Data Tab to 

remove all filters. 

Yes/No Filter 

I like to have a yes/no column for many of my worksheets that I use for tracking items.  One way 

I use yes/no is if a customer has paid me or not.  This is a very quick and easy way to follow-up 

on payments.  I filter for Yes to send a thank you note and I filter for No to place a follow-up e-

mail or phone call.   

Let’s filter our list for who has not paid us, yet. 

1. Click inside our data table in the Jan Tab of the Track.xlsm  

file, 

2. With all of your records showing, click the Drop Down arrow 

on the Yes/No Column and uncheck the Select All item or 

select a cell with  No in it and click your AutoFilter button. 

3. Click the box to check No, 

4. Click OK. 

Now, we know who to phone or e-mail a follow-up to. 
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Let’s determine our outstanding collections. 

1. Sort your Filtered List from Largest to Smallest.  

2. Click and Drag the Items in the filtered Total Column to select them, 

3. Notice your Calculation area in the status bar,  

4. I have all of my functions on. 

 

5. I think I would get busy calling some clients asking: “Show me the 

Money!”, especially Bates Motel. I need to send my collections agent 

to visit Norman! 

Filtering displays only the information you select.  Sorting displays all of your data arranged in 

a particularly order.  Time to “sort” things out. 
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Sorting 

 An Important Gotcha! Always have a backup copy of your Excel file before performing 

sorting!  You can use the Save As feature from your File Tab or pressing the F12 key 

activates the Save As dialogue box for you, too.  While sorting is powerful and easy in 

Excel, many a new user and us old-timers are frustrated because sometimes you may need 

to select your entire area of data to be sorted; otherwise Excel will sort only your selected 

information, such as a single column, and the information will be misplaced in your 

original data worksheet!  Excel 2010 handles this better than previous versions of Excel.  If 

your worksheet is a database or table then you will not have to select the entire area in 

order to sort– simply be in the column of the field you want sorted.  If your worksheet is 

not in a database or table format, such as a balance sheet or income statement with 

multiple subtotals, you will need to select an area to be sorted prior to sorting the data 

area.  For example, you may not want a total or sub-total row included in a sort because 

your information will be distorted. In our worksheet, the Customer data listing is in a 

continuous list without sub-totals and totals and all rows and columns are together and 

have data in most cells, so our sorting will be easy.     

Our first step is to ensure that we have a backup file.  You could sort your worksheet incorrectly 

and click the save icon and you will never be able to return to your original sort unless there is a 

column that you can sort on and retain.  For example, I had a customer that used Excel for 

tracking invoices, the customer wanted to keep the order of the spreadsheet in order of input – 

there was no column or field that kept track of the order of input.  The client performed a sort on 

client name, the client accidentally saved the workbook and the customer could not get back to 

the original order of input.  OOPS! Now, the client uses a number field to keep the order of input 

and to allow a sort on this field. 

Unless your worksheet contains a table with no totals or subtotals or  other calculated row and no 

blank rows or columns, you will need to select or  highlight the entire area of data on your 

worksheet leaving no columns or rows unselected or highlighted in our data area.  We will sort 

two ways:  First, we will use the Sorting icons on the Home Tab and Data Tab as we 

accomplished with our filtering exercises. Then we will use the Custom Sort method in order to 

sort by more than one field or row header.  We will sort a database/table that we will not need to 

select the area for sorting and then we will sort an income sheet that we will need to select an 

area in order to sort.  
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Sorting Command Buttons: A Single Sort  

Here are the steps for sorting using the Command buttons on the Home Tab 

and Data Tab. You may use your sorting buttons that we added to our Quick 

Access Toolbar and you may use the Shortcut menu by right clicking, too. 

1. First in our Track.xlsm file and Jan Tab, 

2. Click cell C8 or any cell with name under the Customer 

heading, 

3. Click  the Sort & Filter button as Pictured at right and 

Click the Sort A to Z item. 

4. You may use the Data Tab and the Sort Ascending 

button in the Sort & Filter Group. 

5. Your information is sorted by Customer name in 

alphabetical order. 

 

 

 

 

 

 A Hot Tip! Notice that Excel changes your sort to A to Z and 

Z to A for Text data, Newest to Oldest and Oldest to Newest 

for Date data, and Largest to Smallest and Smallest to 

Largest for Numerical data!  So this is Sorting for “Dummies” 

and Liberal Arts people like me.  

 

  This worked well because the area we are using is a tracking system type of worksheet.  As 

I related earlier, there will be times when you will need to select the area you want sorted and 

we will accomplish this in our next section. 
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Click the Undo button on your Quick Access Toolbar to remove the sort. 

  Here’s one of my favorite icons in the Office suite the Undo icon.  It should 

be called the Greg Creech key because I make so many mistakes and say Oops! 

a lot.  Clicking this key can get you out of a mess.  Since we clicked it, our sort 

is removed. 

Let’s sort in Descending order or from Greatest to Least as we have previously accomplished. 

1. Click in Cell G8 we want to view our Totals from Largest to Smallest. 

2. Click the Z-A button on the Data Tab or the Largest to Smallest 

button.  Excel Sorted our information. 

 

Let’s sort in Date order or from Oldest to Newest using the right click method. 

1. Right click in the Date 

Column. 

2. From the Short cut menu 

trace to Sort and from the 

Cascading menu choose 

Oldest to Newest as 

pictured here. 

 

 

As I related earlier and repeat here, if you include a total row or cells you may not want in your 

sort, Excel will “mess up” your worksheet – be sure not to save it in this condition.  As I related 

earlier, I always save a copy of my Excel file before I do any sorting activity.  I have 

learned that if I mess up my spreadsheet through sorting and accidentally save my 

spreadsheet I have lost my good spreadsheet forever and must recreate the original sort 

and order of my data!  This is only important if you must keep your original worksheet in order 

of input and there is not a field or column that can be sorted to retrieve the original sort.  A 

couple of messes like this and you will learn as I and my clients have that we should save backup 

copies of our original Excel files. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Custom Sort: Sorting by Multiple Items 

 

Let’s use the Custom Sort method of sorting.  Although the Sorting Command buttons are 

quicker, they are designed for sorting by only one item.  The Custom Sort method of sorting 

allows you to have a primary sort and other sorts.   

 

Here are the steps to sort using the Custom Sorting: 

 

1. First be in our Track.xlsm  file and Jan Tab,  

2. Click inside your data table. 

3. Click on your Data Tab and Click the Sort button and your 

Sort Pane opens. You may use the Custom Sort button on 

your Quick Access Toolbar that we added earlier, too. 

4. Click the Drop down arrow 

for our first sort.  Notice 

you can select different 

areas to sort by such as 

Order, Date, etc.  Also, in 

the “My data has headers” 

is checked.  The Header 

row is important in the 

ease of sorting; if there 

were no header row Excel 

would have Column A, Column B, etc for you choose – Descriptive 

names are easier for me to relate rather than Column A, Column B. I 

think of these column headers as field names of my database. 

5. Click Total. 

6. Ensure Sort On has values in it. Notice that you may sort by color and 

icons, too. 

7. Order should be Largest to Smallest. 

8. Click the Add Level Button 
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9. In the Then by box select Customer, keep sort on Values, and Order 

should be A to Z. 

10. Use the screen above to add sorts for Date and Order.   

11. When complete, Click Ok. 

 

Scroll through and notice how your sort works when you see duplicates in the total field. 

There are records or rows that meet all of the criteria. Let’s Sort the worksheet by Order and 

then by Date. 

 

 

1. Activate your Sort Dialogue box by clicking the Sort Command button 

on the Data Tab. 

2. Sort by Date first in 

Oldest to Newest order. 

3. Then sort by Order in 

Smallest to Largest Order. 

4. Delete the other two 

levels by clicking in the 

level and then clicking the 

Delete Level button. 

5. Click OK. 

 

Now, let’s select an area to sort. 

1. In the Track.xlsm workbook click the Income Tab, 
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2. This worksheet would not be good to 

sort without selecting the correct area 

first.  There are no headers or field 

names and there are breaks in the data 

for calculations – so this is not a 

database and we must select areas to 

sort. 

3. Select the Expenses area A7 through 

G12.  

4. Click the Sort Ascending button and 

Excel sorts your information by the Expense name, since our focus or 

cursor was in this column. Excel will sort based on the “white” cell as 

pictured above. You may press tab and the focus leaves this cell and 

then you can sort by the next 

column using the icons, but having 

the area A7 through G12 is the 

important part of this.  

5. Tab to Column G. 

6. Click the Custom Sort button and 

from the Sort Pane Sort by Column 

G on Values and Order from 

Largest to Smallest. 

 

Excel sorts your Year-to-Date expenses in descending order or Largest to Smallestfor you. 

 

Congratulations!  You have survived and thrived through the Five F’s of Excel:  Formatting, 

Fills, Formulas, Functions, and Filters/Sorts.  We will continue using these Five F’s 

throughout our course.  Now, let’s turn our attention to some Excel efficiencies and to 

creating a multiple worksheet file. 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________  
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Cu s tom Views  

Another nice feature of Excel is the ability to give a name to view that includes hidden columns 

or rows and filtered items.  You can use a Custom View for an entire worksheet or for an area of 

your worksheet.  Custom Views are saved within the 

Workbook but affects a worksheet.  This works similar to 

using names in your Name Box, which we will later. 

Here are the steps we will use to create our custom views. 

1. First you select the area or have your 

worksheet organized with a filter or 

hidden column as you like and that you 

view a lot, 

2. Then on the View Tab, Click the Custom 

Views button,  

3. Click the Add button, 

4. Name your View. 

5. Once you name your views, you can retrieve them by choosing 

Custom Views and from the pane select the View you want, Click 

Show. 

As related earlier, this is very helpful for viewing AutoFilter items, hidden columns or rows 

quickly or collapsed items in subtotals etc.  We will use our Track.xlsm workbook and the Jan 

tab to create views. 

 

1. With your Track.xlsm workbook open, 

2. Ensure the Jan tab is active.  

3. Click View Tab and Click the Custom Views 

button. 

4. From the Custom Views pane, select Bates 

Motel and Click Show. 

5. Excel displays only Bates Motel. 

6. Click your Custom Views button, again, and 

this time choose the Lucy View and Show it. 
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7. Finally, Click the Custom Views button and $1,000 + Orders View. 

We’ll create our own view, now.  

1. Click in a cell containing 

the customer Computer 

Tech. 

2. Right Click on this cell and 

from the shortcut menu 

trace to Filter and from the 

Cascading menu choose Filter by Select Cell’s Value Add. 

3. Excel displays only Computer Tech 

information. 

4. Click your View Tab and then click the 

Custom Views button. 

5. Click the Add button.  

6. In the Add View dialogue box, type 

Computer Tech in the Name: section.   

7. Click OK.  You return to your worksheet with no changes in your view. 

8. Click Custom Views on the View Tab, 

9. From the Selections click Lucy. 

10. Click Show. 

11. You return to your worksheet with only Lucy Goosey items 

displayed and your AutoFilter is active. 

12. Finally, click the Custom Views button and from the Custom 

Views window,    

13. Click Full View. 

14. You return to your worksheet with all of your 

items displayed. 

Let’s hide some columns and save this as a view 

1. In your Track.xlsm Select Columns D through H,  

2. Right Click and from the shortcut menu click Hide 

as pictured here, 
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3. Your Columns are hidden. 

4. Click the Custom Views button.  

5. Click Add, 

6. Name the View Hidden Columns, 

7. Click OK. 

8. Activate your Custom Views and view the 

Full View and then View Hidden 

Columns.. Finally, return to your Full View. 

On your own create some views with filters and hidden rows and/or columns. 

 

 An Important Gotcha!  You may want to Sort your data and save this as a view; I know 

I have, but alas Sorting cannot be saved as a view, YET.   

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Fla sh  F i l l  
 

A cool feature in Excel 2013 and 2016 is Flash Fill. This separates a 

series in a column for you; this is similar to using the Text to Columns 

feature of Excel, only easier. We will learn Text to Columns later, and 

Flash Fill is a terrific way to separate a series.  

 

Here’s how to use Flash Fill. 

 

1. In my Flash Fill workbook, I insert a column and 

type the person’s Last Name (in this case Frogg).  

2. I press enter to go to the cell below and when I 

begin typing the next person’s last name, Excel 

gives a list of the remaining names in gray. 

3. When I press enter, Excel magically inserts all of the 

last names for me. 

4. Next, I insert another column and type a person’s 

first name (in this case Kermitt). After pressing 

enter, I go to the next cell below and beginning 

typing the next person’s first name, Excel offers all 

first names in gray. I press enter and the first 

names populate the column. 

Sometimes Flash Fill may not work for you. You may use 

your Fill options menu to use Flash Fill, too.  

 

As we learned with the date fill, Excel has a Fill Options 

button that is pictured here.  When you use Fill, this button 

will appear and provide shortcuts to select your formatting 

options and other options. The top item is Copy Cells – I use 

my Fill handle a lot to copy formulas and functions in 

Excel. 

Select a cell with your formula and click and drag the area 

to copy your formula too – this works when the areas you 

Excel 2013/2016 – New 
Flash Fill. 
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are copying are continuous.  Using Fill in this manner is like using Copy and Paste but in one, 

visual step.  

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Forming our Formulas  
 

Formulas and Functions Excel are the heart and soul of Excel.  Excel is Excel because of the 

powerful Formulas and Functions that the application uses or that you may produce.  Excel is 

“Excel-lent” at providing very complex and very simple built-in functions for you to use or you 

may create your own formulas.  We will build simple formulas first and then use some of the 

functions in our Fourth F of Excel.  Now,  we need to learn how to “form” our own formulas. 

 

In the beginning is the cell.  As introduced at the start of this course, a cell is the intersection of a 

column and row, for example cell A1 is the intersection of Column A and Row 1.  Generally, A1 

is your “home” cell.  If you are in another section of Excel and wish to return to the beginning of 

the worksheet press the CTRL key and the Home key simultaneously.  We have entered text and 

number in cells and have formatted them.  Now, we will insert formulas in cells and use the cells 

in calculations. 

 

Formulas and functions in cell begin with the equal (=) sign.  A formula in a cell maybe =2+2 

or =(8*2)+10.  However, in Excel rarely will you use a specific number in a formula.  You will 

use various cell references for your formula to get the numeric value.  

Formulas in Excel follow the order of algebraic standards: 

✓ Items in parentheses are calculated first and work left to right, 

✓ Exponents are calculated next, 

✓ Multiplication and Division numbers/cells are then calculated, 

✓ Finally, Addition and subtraction items are calculated. 

Excel uses common Mathematical operators.  The mathematical operators are: 

Mathematical Operators  
Addition + 

Subtraction - 

Multiplication * 

Division / 

Exponents ^ 
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Symbols in Formulas  and Functions 

Below is a table of symbols and what they mean in formulas and functions.  This will help 

explain and use the syntax that Excel needs in order to work properly for your formulas and 

functions. 

Symbol What it means 
: (A Colon, such as A5:G5) 
=Sum(A5:G5) 

Think the word “Through” or A range of  
contiguous cells, so the sample at left 
would be “A5 Through G5”. 

, (A Comma, such as A5, C10, D12) 
=Average(A5, C10, D12) 

Think the word “And” or specific cells 
that are not contiguous, so the same at 
left would be “A5 and C10 and D12”. 

() Parenthesis – Cells used in the 
function or you may see a function 
without cells but have the () which is 
needed for the function to work, such as 
=TODAY() – which will put the date on 
the computer in your work sheet and 
update the date automatically for you. 

Specifies the cells or range of cells 
needed for the Function or to separate 
items that need to be calculated in a 
specific order for your formula. All 
functions must have parentheses, even 
with no cell reference. 

! (An Exclamation Point, 
=SUM(January:December!B5) 
This is a 3D reference. 

Think the word Join, The Exclamation 
points joins or connects different 
workbooks, worksheets, and cells in 
Functions and Formulas. 

= Equal Sign, =A5 + A6+B10 
=Count(A5:G5) 

Think “Excel I’m, giving you a formula or 
function.”  All Formulas and Functions 
must begin with an equal sign =. 

$ (A Dollar Sign, such as $B$5) 
Absolute and Mixed referencing. 
=$B5*$I$5. 

Think the word “Only”. Only use this cell 
in a calculation even if the cell’s formula 
is copied to other cells the cell reference 
will not change.  This is the Absolute 
Reference symbol. 

 Hot Tip! My accountant and number crunching friends would be 

disappointed if I did not let you know that you may begin your Formulas and 

Functions by pressing the + sign.  Folks that use the numeric key pad rarely 

like for their hand to move from the key pad, so they will begin their 

formulas and functions by pressing the plus (+) sign on the key pad rather 

than moving their hand and fingers ALL the way to the equal sign.  Also, the 

only time I use a number in a formula and function is for days of the year, 
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months of the year, or a number that WILL NOT change which is rare in Excel 

analysis and forecasting.  

 

Cell Referencing and Addressing 

Aside from entering numbers for calculations, the primary power of Excel is Cell addressing and 

references:  Cells have various types of addresses and references.  I explain them below and 

demonstrate them in the coming pages.  We will be using these types of addressing throughout 

the course.  Please use this information as a reference in the future.  As we build various types of 

formulas we will refer back to this section. 

Relative Address  

Relative Address: A relative address changes the address of the cell relative to its location.  If 

you enter a formula calculating cell B3 as follows =B1+B2 then copy the cell to C3 the formula 

changes based upon the relative address to =C1+C2.  You may quickly and easily copy 

formulas; we discussed this in our previous section Excel F2 – Fills and will use this in the 

upcoming exercises. 

Absolute Address  

Absolute Address: An absolute address of a cell does not change.  The absolute address symbol 

is the dollar sign ($).  If you enter a formula in B3 as =$B$1+B2 and then copy the formula to 

C3 the formula becomes =$B$1+C2.  The absolute address allows you to specify your 

calculation using a specific cell for all calculations.  As an example, if you want your expense 

items to increase by 3%, you would place 3% in a cell and reference this cell in your expense 

calculations using the $ symbol.  When you see a $ in a formula, function, or cell reference think 

the word “only”, such as if you see $A$1 think “only use Cell A1 – do not change this reference 

even if I copy it.” We will use this for our forecast, VLOOKUP, and other functions/formulas 

later 

Mixed Address 

Mixed Address:  This uses both relative and absolute addresses.  If you want the reference in a 

particular column or row not to change and another reference in a particular column or row to 
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change, you would use  =$A1+B1 in cell C1 (Column A would be used however the row would 

change).  If you copy this cell to C2, the formula becomes =$A2+B2. 

3-D References 

3-D References: This uses cells in other worksheets.  The exclamation point (!) separates the 

worksheet name and actual cell.  If you want to add January rent and February rent for a total in 

March, you would enter a formula in the March worksheet as follows:  

=January!B5+February!B5 (Note that your formula bar will guide you through the calculation 

and illustrate your position in accomplishing the formula or function.) We will use this for our 

summary worksheet later. 

 

Confused?  Dazed?  Join the club!  Plan your formulas, play around, and at the final straw 

(usually when you get the #VALUE, #REF, or another error for the 100th time) rely on Help by 

searching on Cell Reference by pressing the F1 key or pressing the Help button. 

 

Since we have had an overview of formulas and cell referencing, we will begin “forming” our 

formulas in our Budget.   

1. With your Budget workbook Open, we will input a formula in Cell D5. 

2. Click in Cell D5 and Type (or you may click your cell reference) =B5-C5.  

This will calculate the difference 

between our budget and our 

expense.  Notice the information is 

in your formula bar and cell 

3. Press the enter key. 

4. Our calculation appears! 

As you construct your formula, you can type your cell references instead of clicking them if you 

like. We could use our Fill Handle to copy this formula down through the column, but let’s get 

practice manually inputting formulas.  This time instead of typing the formula we will use the 

click method. 

1. Click in Cell D6 and Type =, 

2. Click Cell B6, Notice the Cell Reference of B6 appears in your D6 Cell 

and Formula bar, 
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3. Type a – dash or minus sign for subtraction, 

4. Click Cell C6, 

5. Press the Enter key, 

6. Our calculation appears. 

 

A Hot Tip!  Now, let’s use the Fill Handle to copy the remaining cells. 

1. Click cell D6, 

2. Position your cursor over the right, 

bottom corner of Cell D6 when you 

see the plus (+) sign Click and 

Drag down to row 15 or if you 

double click Dr. Fill in cell D6 our 

formula will fill to Cell D13 and 

then we would need to fill through 

D15 for our Total and Average 

functions that are upcoming. 

 A Hot Tip!  Simply double click the 

(+) fill sign in Cell D6 and the 

formula will fill down automatically 

to the bottom of the worksheet area.  Fill will go down as far 

as the adjacent column goes. We’ll use this in some 

productive ways in the advanced part of your education.  

Fantastic!  Excel and Dr. Fill has copied your formula and included the formatting, too. 

We have calculated our differences between the budget and the expense items.  We will be 

developing other formulas throughout the course.  But we have our foundation for formulating 

our formulas.  Now, to put the Fun back into Functions! 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

  

+ 
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Putting the Fun into  “Fun”ctions  
 

AutoSum 

 Now, that we can calculate cells based upon data in other cells - let’s make life easy and 

powerful with built in functions.  We will be using some of the most popular and easiest to use 

functions here and some of the more complex functions later in our course. 

 

On your Home Tab you will see the AutoSum and a Drop Down Arrow next to it on 

your Editing Group and is pictured to the right.  You may use the Formulas Tab, too 

picture here as well. Use the AutoSum key to summarize a cell range.  Use the Drop 

Down arrow to select a common function and this offers you other functions that will 

provide assistance in creating other functions .  If you are a Liberal 

Arts Major, don’t freak out by all of the functions!  If you hate 

algebra, trigonometry, or other mathematical equations just the 

names of some of these functions will scare you.  If you are an 

accountant, scientist, engineer, or numbers crunching financial 

analyst you will love these scientific, financial, and other 

mathematical wonders, you have found numbers heaven.  For the 

numerical challenged or brave heart take a peek at the Statistical 

Function category and Function names.  This intimidates me, but may thrill you!  We will use 

several of the functions.  First, let’s use the easy and powerful AutoSum key. 

Ranges of cells may be selected by typing or selecting the first cell, typing a colon (:), and 

typing or selecting the final cell to include in your function.  For example, notice on the January 

worksheet that cell B20 Sums cells B5 through B19.  We can also select a cell and click and drag 

for Excel to select the range for us.   

Sum:  You may type Sum after entering an equal (=) sign or select the cell in which you want to 

Sum and press the AutoSum icon.  Like mathematical magic, Excel enters the =SUM formula 

and will provide the range in which you want to sum!  If the cell range is not correct, use your 

mouse to click and drag the correct range to Sum and press the enter/return key.  The result is 

displayed. 
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Let’s use the Sum function by clicking the AutoSum icon.  Here are the steps: 

 

1. Click in Cell B14. 

2. Click the AutoSum icon. 

3. The formula:  =SUM(B5:B13) should be 

displayed.  If not, you may type the 

range here or click and drag to select the 

correct range.  

4. Press Enter. 

5. Your total appears for this range of cells. 

Wow!  Even a “Math Challenged” person like me can use 

this quick and easy icon to perform totals and subtotals in 

columns or rows. 

 You may also use the fx -  Insert Function button by the Formula bar to 

activate the Insert Function dialogue box we will use in a moment.  The buton 

is pictured at right.   

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Time to recall our friend the Calculations in the status bar.  As described earlier, the status  bar 

will quickly provide you results of functions, including Average and Sum. 

 

1. With your Budget.xlsx open, 

2. Click Cell B5 and Drag to Cell B13; 

3. The Calculations should show on your status bar based upon our 

selections earlier in the course.  

 

The syntax for our functions is very important.  If proper syntax is not used, Excel will give you 

error messages or calculate incorrectly.  Here are the important notes  to remember: 

 

✓ All formulas and functions begin with an equal sign =. 

✓ Paretheses are used in functions to separate the function name from the range of cells 

or  the specific cell(s) that is to be used in the calculation. 

✓ The colon is used to specify a range. 

✓ Other separators such as commas may be needed for a function which we will use later 

with the PMT function. 

Let’s enter the SUM function manually in Cell C20.  Here are the steps. 

1. Click in Cell C14. 

2. Type: =sum(c5:c13) (Notice I used lower case letters, Excel will 

convert the text properly for you.) 

3. Press Enter. 

4. Your result appears. 

5. Click and Drag Cell C5 through C13 and verify the accuracy of the 

SUM function with the calculation box. 

Let’s practice by creating a Sum in cell D20 for the range D5 through D19 either typing in the 

function or using the AutoSum icon.  Note  We had better hope to see a positive number in 
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this cell or else we have blown our budget!  Now, that we have mastered the AutoSum icon and 

the SUM function, let’s use the Average function.  

Other Functions 

Using the Drop Down arrow next to your AutoSum icon will provide a 

list of popular functions as well as the ability to activate more complex 

functions using the More Functions… item on this menu.  We will use 

the More Functions. .. later. Below are some of the other functions we 

will use.  The Average and other functions use the same syntax, instead 

of SUM being in the formula other text is substituted – the rest of the 

syntax is the same. 

 

 While I like for Excel to assume certain ranges, care must be 

given in examining Excel’s assumption of ranges to ensure that the range is correct. Don’t 

assume that Excel will be correct. Excel is smart, but not that smart.  

 

Average:  Provides the average of selected cells.  Formatted as:  =Average(B5:B13) or 

=AVG(B5:B13). 

Max and Min:  Provides the largest (maximum) number in a selected range of cells and the 

smallest (minimum) number in a selected range of cells.  (Duh!) 
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Count:  Will do just that:  Count the numbers in your 

selected list of cells, for example, Cell B5 through B19 is 15 

numbers.  The function displays as =Count(A5:A19) 

Let’s use the Average Function is Cell B15 and C15.  

Here’s how: 

1. Click Cell B15, 

2. Click Drop Down arrow next to the 

AutoSum icon, 

3. Click Average,  

4. Excel will “guess” B5:B14 – this is wrong! 

5. Edit the function in the Formula Bar as 

pictured at right or in the Cell B15. 

6. Change the Cell reference from 14 to 13 – Select your number 14 and 

type over it with 13. 

7. Excel will provide a Blue Border around your range for you to see the 

range you have entered. ☺ If you are under 50 years of age and have 

good eyesight you may use the blue boxes at the edges of the blue 

selected area to click and drag the cell range reference, too. I’m too 

old and too spastic with a mouse to use this method, but try it! ☺  

8. Press enter. 

9. Your Function is correct. 

10. Using your fill handle in Cell B15 fill this Function over to Cell C15 and 

notice that Excel and Dr. Fill will 

change the reference from B5:B13 to 

C5:C13 – this is using Relative Cell 

Addressing or Referencing. 

Now, create your own Count function by 

typing Number of Items in the cell below your 

Average Cell and then enter the functions in as 

displayed at right. I have added a row for 

Travel which we will accomplish later so your 

cell range reference will be different. 
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 Excel will guess your range of numbers for a Function in the following manner:  

✓ If there are numbers to the Left of the function Excel will assume all of the cells with 

numbers in them to the left. 

✓ If there are no numbers to the left, Excel will assume numbers above it. Excel will us 

all of the cells with numbers above the cell containing the function – much like the 

Average function included the wrong Cell in its assumption. 

✓ Excel doesn’t usually assume or guess a range if it doesn’t “see” numbers to the left or 

above the function cell.   

So we have begun really Excelling at Excel.  We will look at several great functions throughout 

our course, such as the PMT, CONCATENATE, VLOOKUP, IF THEN ELSE and many more.   

Great!  We have our January budget and expenses completed!  We will build February through 

December after we look at our final F - Filters and Sorts. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Loan Workbook 

I promised you that we would build a couple of workbooks and that this is the best way to learn 

Excel or any application.  Time for us to create our own Loan Calculation Workbook and then 

our own template. While there are templates for these types of workbooks in Excel, the template 

won’t help you learn how to customize and build your own.  In this section we will build a Loan 

Workbook that will contain a Loan calculation worksheet for payments.  Then we will build an 

amortization schedule to accompany our repayment plan.  Throughout we will use knowledge we 

gained from our previous exercises such as formatting our worksheet and using formulas and 

functions.  We will learn new features of the Excel,  like Name Manager and defining Names, 

too. 

 

S e t t ing  up  th e  Loa n  Wo rk sh ee t   

As I have related earlier, Excel has many excellent and advanced functions.  I know scientists 

that use these advanced functions.  I have taught (or I tried to teach) research doctors, engineers, 

and other mathematical wizards advanced functions (actually they taught me!).  There are entire 

books and volumes to document these great areas of Excel.  I’m sticking to that which I know 

best – great personal and general business applications.  The PMT Function is an excellent way 

to calculate a loan’s payment and develop an amortization schedule.  I use this all the time to 

track my mortgage or to play “what if” games when I’m researching a car loan or other type of 

loan.  I have included a sample of the workbook we will build entitled Loan.xlsx. 

We will create our loan calculator using the PMT Function and we will build a tracking system 

of our payments.  Let’s go! 

1. Let’s open a blank Worksheet, in cell A1, type Our Loan Workbook, 

2. Select cells A1 through H1, 

3. Click the Merge and Center button, 

4. Format this merged and centered cell (A1) as follows or use your own 

creativity: 

5. Change the Font, 

6. Increase the Font Size, 

7. Change Font Color, 

8. Apply Shading and a Border, 
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9. In cell B2 type Rate, 

10. In cell B3 type Months, 

11. In cell B4 type Loan Amount, 

12. In cell C2 Type .0775 and click away from this cell, 

13. Click cell C2 with your .0775 displayed to select the cell, 

14. Click the Percent Sign command on the Number Group in the 

Home Tab. 

 An Important Gotcha! The Percent (%) button on the numbers group doesn’t 

provide decimals, but the Percent sign in the Numbers Gallery provides two decimal 

places. Excel will round most numbers so if you need to view the actual number, you’ll 

need to use the increase decimal command button, as we will do, next.  

15. Click the Increase Decimal button twice to change 8% to 7.75%, 

16. In cell C3 type 360 (Number of months of our loan), 

17. In cell C4 type -85000 (Type a negative 85000 since this is a loan 

or debit), 

18. Format cell C4 as Accounting, 

19. Change your worksheet Name to Loan Calculator and change your Tab 

Color, 

20. Save your file as Loan. 

 

This is mortgage 

information for an 

$85,000 loan over a 

30-year period at 

7.75% APR interest 

rate. My lovely Loan 

Workbook displays 

here. 
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Na me Bo x  

The Name Box, located to the Left of the Formula Bar, is a way 

to give a cell or a range of cells an English name.  This will 

allow you to use the English Name in calculations or to quickly 

go to this cell using the Name Box’s drop-down arrow.  We will 

use the Name Box to name cells, an area of our worksheet, and 

to use in calculations. 

 

 An Important Gotcha! You cannot use spaces in Names 

you enter in the Name Box; Excel gives you an error 

message, if you put a space in 

a Name.  Also, press the 

Enter Key after you type in a 

name; otherwise, the Name 

Box will not save your text. 

So, no spaces in Names and 

press the Enter Key after you type a Name. You may use an Underscore character for a 

space if you like.    

 

A Hot Tip!  Here five reasons we will learn to love the Name Box and Name 

Manager: 

1. Makes a cell reference absolute (you can use a name rather than the dollar 

signs - $A$1), 

2. Navigation, 

3. Selection, 

4. Used in formulas and functions, 

5. Store Values.    

 

Let’s use the Name box to “name” our 7.75%, 360, and $-85,000 

Here are the steps for adding a Name to a Cell. 

1. Click cell C2 with our Percentage, 

2. Click in the Name Box, and type Rate and press enter, 

3. Click cell C3 with our figure of 360, 

Name Box 
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4. Click in the Name Box, and type Months and press enter,  

5. Click cell C4 with our figure $(85,000.00), 

6. Click in the Name Box, and type LoanAmount and press enter,  

7. Click cell C6 which will contain our Payment Function, 

8. Click in the Name Box, and type Payment and press enter, 

9. Click and drag to select cells B2 through C6, 

10. Click in the Name Box, and type LoanInfo, and press enter. 

Now, let’s use the Name box for navigation and selection. 

Go to another worksheet, and click the down arrow on the Name 

Box and click a name to quickly go to that worksheet and cell.   

 

 Hot Tip! The Name box helps in maneuvering and in 

navigating to different areas of your workbook quick and 

easy. I once had all of the total of a worksheet on row 57,569 

I named that row TheBottomLine and any time I needed to 

quickly go there I could using the Name Box no matter what 

other worksheet I was.  

1. In an empty cell type =LoanAmountt+5000. 

2. The result will be –80000 (Remember our loan is a negative number!) 

3. Clear the cell. 

The Names take on the value of the cells and update as you change the figures in the cells. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Na me Ma nag er  

Excel has a great feature to help you with Names – The Name 

Manager. This will allow you to edit your names, create new 

names, delete names, and change the cell reference or value.  

The Name Manager is pictured here and is part of the 

Formulas Tab and the Defined Names Group.  

Notice I have LoanAmount 

selected, so my buttons at top 

are all active. You can Edit and 

Delete Names and Cell 

References here and create new 

names for specific cell(s).  You 

can used the Refers to: section 

to type your cell references or 

you can use the Collapse button 

to click your cell references.  As 

I related earlier Names by 

nature are Absolute Reference 

and the Refers to Section with 

the =’Loan Calculator’!$C$4 

pictured at right demonstrates. 

Let’s add a new name to 

represent a constant value.  We’ll use .54 as if this were a percent or maybe mileage at cents 

per mile.   

1. In your Loan Calculator worksheet, click the 

Formulas Tab and click the Name Manager command 

button, 

2. Click the New Button in your Name Manager,  

3. For the Name enter: Mile, 

4. Keep the Scope at Workbook, although you can store 

names in specific worksheets, 

5. Provide an appropriate comment, 



Page 74 Excelling at Excel  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 

No Duplication Permitted  404-299-1706 

6. In the Refers to section enter =.542 (our constant value), 

7. Click OK, 

8. Click the Close button in the Name Manager window, 

9. Click in Sheet 2 and click in any cell and enter the formula 

=100*Mile. Notice as you type Mile that Excel provides 

the AutoComplete feature for you to double click the Mile 

label to insert the name into your formula.  

10. Press enter – Excels provides the calculation.  

In reality, our constant numbers are not so constant and values, like mileage, change. Let’s 

edit our name for a new value. 

1. Click your Name Manager button and select or highlight Mile, 

2. Click the Edit Button . . .  

3. Your Edit Name pane appears, in the refers to section change the value 

to =0.6, 

4. Click OK,  

5. Click close at the Name Manager pane. 

6. Your value for your name changes in the formula’s result. 

The Other command buttons on the Defined Names Group are 

good for creating and using names without the Name Manager. 

The Define Name button allows you to create new names by 

opening the New Name page for you and to apply names.  The 

Use in Formula button lists your names for you to use in a 

formula, if you click a name Excel begins your formula in the 

formula with an equal sign and your name.   

 

We could have used the Create Names From Selection command button, too.  

This allows you to select a Range for example B2: C6 in our Loan Calculator 

worksheet and name the cells base on adjacent cells. For example, this 

would automatically name cell C2 Rate based on cell B2. 
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Th e  PMT Fu n c t io n  
Let’s create our Payment Function. 

1. Click in cell C6; notice that the Name Box displays the word Payment – 

we named this cell earlier. 

It is important to be in this cell; our payment function will be here. 

2. In the Formula Tab, click the Financial arrow and the pick list will 

include PMT.  

We could have click the Insert Function button by your 

formula bar or on the Home Tab use the AutoSum Command 

button’s menu and chosen More Functions, 

3. The Insert Function Dialogue box opens. 

 

The Insert  Function Dialogue Box 

You can find a function by giving a description of the function or what you 

want the function to perform using the Search for a function section and 

Click Go. 

 

1. In the Or Select a Category: section you 

can choose Most Recently Used, All, Financial 

or other Categories. 

2. If the PMT function is not in your Most 

Recently Used Category then click the Drop-

down arrow and scroll to Financial Category. 

3. In the Select a function: area scroll down 

and notice all of the functions! 

4. Locate and select PMT and click OK, 

5. Our PMT Function Dialogue box appears. 

The Function Arguments dialogue box here.  ☺ If there 

is anything I can do well in Excel, it is to argue with my Functions! ☺  

We will use this to construct our PMT function 
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Notice the button at left which is located at the end 

of each row for our Rate, Nper, and PV, etc. This is 

the Collapse Box.  Clicking this 

will take you to your worksheet 

allowing you to select a cell or a 

range of cells.   

 

Once you click the Expand button, a row will 

appear with the Collapse button at the end.  

This is the Collapse button.  Once you click and select your cells you click this button to 

return to the dialogue box in which you are working.  You will notice these boxes as you 

work in functions and other areas of Excel. 

 

These two buttons and functions in Excel take some getting use to and practice. However,  you 

don’t have to use them in this case. In the Rate box, simply click cell C2 our Rate cell and 

Excel will place the cell reference Rate in the box for you. 

 

If you used Names for your cells, the names will appear, such as Rate, not the cell reference.  

I’m demonstrating how to use the paste function dialogue box using cell reference and Names.  

 

 

1. You can type your reference, click Cell C2 or In the Rate Row Click 

the Collapse button.  

2. In your worksheet click Cell C2.  Notice Rate appears on the Row with 

the Expand Button and a scrolling marquee around your Rate or Cell.  

3. Type /12.  Our row should 

appear like this Rate/12.  

We must do this since this 

is an annual percentage 

rate and we are 

calculating monthly 

payments; therefore, we 
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are calculating a monthly percentage rate.  Click the Expand button. 

Notice your Formula Bar updates as you work in the Function 

Arguments box.  

4. Type Months or In the Nper Row, click cell C3 or the Months cell, 

5. In the Pv Row, type 

LoanAmount or click C4.  

Your Function Arguments dialogue box 

should look like the one here.  Notice the 

formula result area which contains 

608.9504087; this is our payment. 

6. Click OK. 

Cell C6 Contains our Payment.  Look in 

the formula bar to see the formula we 

created.  

Save your workbook. 

 

As pictured here, you may also use the 

cell reference rather than Names as we 

assigned earlier.  The figures and 

results do not change just the cell 

reference name.   

 

 

We have a method for calculating our 

loans and payments.  Change the interest 

rate by typing .07 or .10, etc.  Change 

the number of months and loan amounts 

to see different principal payment.  How 

much would the payments on a $34,300 loan for a car with a 5 year repayment at 6% interest be?   

We will change these figures and create several “what if’s” and learn the Scenario Manager 

later in our course. 
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 Why didn’t I just type in my numbers in the PMT Dialogue box?  Why use cells?  And why 

use the Collapse and Expand buttons?  First, like using absolute reference, it is easier for me to 

change numbers in the cells to calculate different interest rates, amounts, and time periods.  If I 

used numbers in the PMT dialogue box, I would have to go through this each time I wanted to 

change a number.  Using Cell reference allows me much less pain and suffering when using the 

PMT dialogue box.  I used the Collapse and Expand buttons to accustom you to using these 

buttons that you will see in other Excel features, such as in the Page Set-up and Set Print Area.  

You can click your cells to insert a reference or type the cell references and formulas in the PMT 

dialogue box rows as well as using the Collapse and Expand button.  

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

  



Greg Creech Excelling at Excel  Page 79 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Track ing  Wo rk sh ee t  a nd  Amo r t i za t io n  

S ch edu le  

Excel is used, and at times, misused as a tracking system.  Relational databases are designed to 

track large amounts of information and ensure accuracy; however, they tend to be more difficult 

and time consuming to 

learn.  Excel is easier to 

use and can track large 

amounts of information; 

however, what we give up 

in accuracy (such as 

duplicating records) we 

gain in ease of use.  Excel 

has abilities to recognize 

and help with duplicates.  

We will use Excel to track 

several types of items and 

to use Excel as a simple 

database. 

 

Let’s create an 

amortization schedule to 

track our payments on 

the loan we created.  We 

will learn more about 

formulas and new 

formatting techniques, 

such as Text Wrapping. 

 

In our Loan workbook, we will create a tracking system below the loan information.  Pictured 

here is how our worksheet will look. 
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Since we want to track monthly payments, we need to calculate monthly interest payments; 

therefore, our first task is to create the Monthly Interest in cell G2. 

1. In Cell F2 type Monthly Interest. 

2. Select Cell E2 and F2 use Merge and Center to create one cell for this 

text. 

3. Using the Name box, Name cell G2 MnthInt. Don’t forget to press 

enter for the Name box to accept your Name for cell G2. 

4. In cell G2, create the formula: =Rate/12 and change the format to 

percentage and increase the decimal places. Your cell G2 should have 

the Name and formula as 

displayed here. We will use 

this cell in our calculations in 

the next section. 

Now, let’s create our Financial Database. 

 

In Row 8 we will put our column header information or I like to think of this as our field 

names for the database. 

 Very Important Notes:  In order for Excel to work properly as a tracking system, a 

header row must be present.  The header row will serve as our field names for our database 

and the rows underneath the header row will be our records of data.  I can never stress 

enough the importance of maintaining this type of organization.  If you were to use Excel with 

a relational database application or query, this is how we need to organize our data table.  

Subtotals and categories in another row will wreak havoc when trying to use database 

elements in Excel.  As previously related in this course, your list should not have blank rows 

or columns; blank cells are ok but not entire blank rows or columns. Also, you data table 

cannot connect to other cells with data, that’s why I start on Row 8 and not Row7.  
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Using the picture below, you should type the Date and other text in the 

cells in Row 8. Don’t worry about the format and having your text truncate 

within the cells; we will learn text wrapping next that will allow your 

headers to appear as if on two rows.  Once we enter the data, we will 

format the information; therefore, in cell A8 enter Date, in cell B8 enter 

Loan Balance, in cell C8 enter Interest, in cell D8 enter Principal, in cell E8 

enter Additional Principal, in cell F8 enter Total Principal, in cell G8 enter 

Total Payment, and finally in cell H8 enter New Balance. 

After you enter your text, the text is truncated between columns and not very attractive; let’s 

change that using the Text Wrap Feature. 

1. Click and drag to select Cells A8 through H8,  

2. On the Home Tab, click the Wrap Text button,  

3. Using the Home Tab and Alignment Group, click 

the Center alignment buttons for vertical and 

horizontal alignment. 

4. While Text Wrapping does a good job, it is not 

perfect and we may need to make additional width 

or height changes to the cells, rows, or columns. 
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1. Enter 04/01/2018 in cell A9, 

2. With cell A9 Selected, get your Fill Handle,  

3. With your Fill handle, click and drag down to cell 

A100, 

4. Using your Fill Options box, click Fill Months to 

provide us with the 1st of every month for several 

years, 

5. Using the Numbers Group and the Numbers format 

box choose Short date from the menu, 

6. Click OK. 

We have accomplished our payment date schedule. 

 

Let’s create our formulas to calculate our payments and reduction in the Loan over a period 

of time.  Don’t worry about learning to create a schedule like this; concentrate on how we 

construct the formulas, not necessarily the specific cells or calculation.  Learning the syntax 

of creating these formulas is more important than learning how to construct a payback 

schedule such as this. 

   

1. Enter =-LoanAmount in cell B9.  We must enter a 

negative sign (-) for Excel to make this a positive 

number, since our Loan Amount is a negative 

number. Notice Excel will provide an AutoComplete 

for your Names. You can click your name in the box 

and Excel inserts the Name in your cell. This starts our loan and this 

cell will change based upon our cell C4 which we named LoanAmount 

earlier. 

2. 85000 will appear in this cell.  We will format all of our cells later. 

 (We put the negative (minus sign) before LoanAmount to serve as a double negative with the 

$85,000.00 making this number positive.) 

1. In cell C9, we need a calculation for the Interest.  

The calculation is:  =B9*MnthInt 
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 (Remember we named cell G2 as MnthInt; we could have used absolute reference of $G$2 in 

our formula.) 

2. 548.9583333 appears in cell C9. 

Next, we need to take our Payment minus the Interest to arrive at our 

Principal payment.  We named cell C6 Payment earlier and input the PMT 

function, too. 

1. In cell D9 enter following formula:  =Payment-C9.   

2. The Figure 59.99208 appears in cell D9. 

 

For cell E9, we will leave this cell, the Additional Principal, blank for now. 

1. Cell F9, our Total Principal cell, should contain the following formula 

=D9+E9, 

2. The Figure 59.99208 appears in cell F9.   

3. Cell G9, our Total Payment cell, should contain the following formula 

=C9+F9, 

4. The Figure of 608.9504 appears in cell G9. 

5. Cell H9 should contain the following formula for our New Balance 

=B9-F9.  This subtracts the Principal payment from the loan. 

6. The Figure of 84940.01 should be our New Balance (Whoopee!)  

 

Our first row of data is complete.  Now, our loan has begun and our future payments are 

based upon New Balance, not the Original Loan Amount as our first row indicates. 

 

1. In cell B10, enter =H9 (The Loan Balance), 

2. The figure of 84940.00792 should appear as our Loan Balance in cell 

B10.   

3. Select or highlight cells C9 through H9.   

4. Using the Fill Handle in cell H9 fill down one row. Your New Balance 

in Cell H10 should be 84879.63. 

5. Save your Workbook. 
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Now we can use our fill handle for the Cells B10 through H10 and fill down to row 100 to 

complete our calculations and then we will format this area. 

 HOT TIP! Remember you can select your row B10 through 

H10 and get your Fill Handle in cell H10 and double click to 

fill your formulas and cell formatting all the away to row 100.  

This is quicker and easier than the click and drag method 

described below.  

1. Select cells B10 through H10.  

2. Get your Fill Handle in cell H10 and double click to fill to cell H100 or 

click and drag through Row 100.  

Your pay back schedule through many years is complete.   

   Hot Tip! Show Formulas – The Excel Formula Tab has a 

terrific button called Show Formulas, which is exactly what it 

does. I am using this button below to display our formulas for 

the Loan Workbook.    

 

+ 
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Let’s format Cells B9 through H100 as Currency using a new way of selection with the Name 

Box. 

1. In the Name box, type B9:H100 and press enter to quickly select the 

area. 

2. Click your Numbers Format Box and select Currency or Accounting in 

the Menu, 

3. Save your file. 

Our amortization schedule is complete.    You can continue using the spreadsheet for years by 

Filling in the data past Row 100.  

Let’s name our tracking system FinancialDB. 

1. In the Name box, type A8:H100 and press enter, Excel selects this 

large area for you. 

2. In the Name Box, type 

FinancialDB and press enter.   

With our Named database, selecting this 

area for printing, copying, and other 

functionality is much easier than trying 

to click and drag or using other methods to select this area. 

Click in another worksheet, and when you want to select your Amortization 

information, go to your Name box and from the list, click 

FinancialDB. Excel lists your names in alphabetical order. 

 

Play around.  Change the interest Rate, the Months, and the Loan Amount.  

When these figures change, your pay back schedule automatically changes 

and recalculates for you.  You can calculate early payoff by using the 

Additional Principal payment field.   

 

 

 Write your notes here: _______________________________________________________ 

 

          ________________________________________________________________________  
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Scenario Manager:  A What If Wonder!  

As we have learned with our Loan worksheet, we can change the Loan Amount, the Interest 

Rate, and the Terms to play “what if” games.  But, we must continue to input and change the 

items to see the results.  Excel contains a tool called the Scenario Manager, which can keep 

track of our “what if” games and display them for us.  You can use Scenario Manager to 

analyze a lot of “what if” statements and analysis.  We will use our Loan.xlsx workbook to 

create various scenarios. 

 

Let’s create several scenarios using Excel’s Scenario Manager. 

1. Open the Loan.xlsx workbook and in the Loan 

Calculator worksheet click in your Loan Information 

area, such as Rate or Months cells – this helps 

Scenario Manager better know the area for your 

scenario. 

2. On the Data Tab and in the Data Tools group click 

the What-If Analysis button, 

3. Click the Scenario Manager. . . from the menu, 

4. The Scenario Manager pane appears as 

displayed here. We will add a few scenarios. 

5. Click the Add… button. 
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1. In The Scenario name box type Original. 

2. You may click and drag your area on your 

worksheet and Excel will collapse and 

expand the box as needed to enter your 

selection or click the collapse button at the 

end of the Changing cells row.   Your 

dialogue box reduces and you can see more 

of your worksheet.  The Add Scenario – 

Changing Cells dialogue box appears. 

3. Click and drag the cells that we will 

change - C2 through C4. 

4. A Scrolling Marquee around these cells indicates that the area is 

selected. 

5. The reference of $C$2:$C$4 appears in the changing cells box.  This is 

Absolute Reference, again. 

6. Click the Expand button; Excel returns to your Edit Scenario Dialogue 

box, 

7. Click in the Comments section, notice Excel has put your name and 

date in this section.  Click before this information and type: 7.75%, 

30 Years, and $85,000 as pictured above or put in your own 

comments to help describe the scenario, 

8. Click OK. 

9. The Scenario Values box appears with 

our information.  We do not want to change 

these values as we want to create a scenario 

of our existing data. 

10. Notice that the words Rate, Months, and 

LoanAmount appear; these are the names of 

our cells C2, C3, and C4.  If we had not named 

these cells, then the cell reference of C2, C3, and C4 would appear 

here.  This is another advantage of using Names as cell references. 
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11. Click OK. 

Our Scenario Manager Screen returns with the Original Scenario 

selected.  

 

 

 

Let’s add another scenario with a different interest rate and time 

period. 

1. Click Add, 

2. In the Add Scenario Dialogue box and the 

Scenario Name section type 5%, 15 Year,  

3. Ensure the changing cells box displays C2:C4, 

4. Click in Comments and enter additional 

comments as pictured at right, 

5. Click OK to activate the Scenario Values, 

6. Change the Rate to .05, 

7. Change the Months to 180, 

8. Click OK. 

So, nothing changes and your rate and months remain the same.  If 

your Scenario Manger Dialogue box is blocking your Rate, Months, 

and Loan Amount section of your worksheet, click on the Title Bar of 

the Dialogue box and move it to the right, so you can 

see your changes. 

1. At the Scenario Manager screen, 

select the Scenario of 5%, 15 Year 

Loan Scenario, 

2. Click the Show button at the bottom 

of the Scenario Manager pane,  

3. Notice your worksheet data changes. 
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4. Wow! I’m no financial wizard, but what a difference this makes over 

the life of your loan. 

5. Notice that your Amortization table changes, too!  

6. Select the Original scenario and click Show – Notice your original data 

displays. 

Let’s add a few more scenarios; please use the above screens if you need help in reviewing 

the actual screens that I will mention in the steps below. 

1. Click Add, 

2. Name the Scenario 4%, 30 Year, $175,000, 

3. Type appropriate Comments, 

4. At the Scenario Values box enter 

the data as displayed at right.  

Don’t forget to put the negative 

sign in front of the LoanAmount 

figure, 

5. Click Add to go directly to the next 

scenario. 

Excel will save this scenario for you, but clicking Add allows you to create 

other scenarios without returning to the Scenario Manager screen and 

clicking add. 

1. At the Add Scenario screen, Name this 

Auto Loan and enter appropriate 

comments, 

2. Click and enter the values as picture 

at right, 

3. Click OK.  

Let’s look at our scenarios. 

1. At the Scenario Manager screen, click 

your Auto Loan Scenario and click Show, 

2. Click 4%, 30 Year, $175,000 and click Show, 

3. Click Original and click Show, 
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4. Click close on your Scenario Manager. 

Excel saves your scenarios with this worksheet and workbook.  You can return to these 

scenarios by clicking the What If Analysis button on your Data Tools Group and then clicking 

Scenario Manager from the cascading menu.   

On your own, create various scenarios changing the Loan Amount, Months, Interest Rate. 

Now, let’s generate one worksheet that will display all of our scenarios. 

1. If your Scenario Manager screen is not 

active, click the What If Analysis button 

on your Data Tab, and from the Cascading 

Menu, click Scenario Manager. 

Notice that you can Delete, Edit, and Merge 

Scenarios.  I never use the Merge feature, but I 

do like to Delete scenarios, I no longer use, and 

I will edit Scenarios, too. 

2. On your Scenario Manager screen, click 

the Summary button . 

3. You may need to change the Result Cell 

or ensure cell $C$6 is displayed in the 

Result Cells, since this is the cell with the PMT function and is the 

calculated scenario cell, 

4. C6 is the cell that changes based upon our 

Interest Rate, Months, and Loan Amount and 

contains the important payment function. This 

is the cell that guides our decision.  

5. Click OK. 
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Excel creates a Scenario Summary worksheet for us to view our scenarios. 

Click the Scenario Summary worksheet and view your “what if” games.  My 

Scenario Summary is 

pictured here. 

On your own, you should 

return to your Budget and 

in the Forecast worksheet 

create scenarios using 

different Budget Increase 

and Expense Increase 

percentages to play your “what if” analysis based on changing these cells. 
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More Functionality with Functions  

Let’s examine some of the other neat functions and formulas to know in Excel.  

Da te  Ca lcu la t ion s   

Since Excel is so great with formulas and functions using cell referencing and numbers, it is 

terrific at Date Calculations, too such as Age and service anniversaries.  You do not want to 

manually enter an age, unless you want to constantly update your worksheet with the correct age 

and we grow older by the minute.  We will look at several different age calculations.  Let’s first 

examine how you can calculate age and service anniversaries that are based on a Date of Birth 

and Hire Date and using the TODAY() function. 

 Please ensure that you format your dates as date, such as Short date, using your format 

cells dialogue box.  Also, Excel stores your dates as numbers.  Every day since 01/01/1900 is a 

serial number for 01/01/1900 is stored as 1 and 01/01/2008 is 39448. That’s how Excel can 

compute time intervals – the date 

formats are for our benefit not 

Excel’s.  

1. Open the Excel 

Workbook named 

Personnel File. 

2. Click in Cell V2 below 

the Age header.  

3. Enter this Formula in Cell V2  =Today()-Q2. Wow, this measures our 

age in days.  This is popular to know for time intervals for shipping, 

ordering, billing, and other important business information dates.  I 

used this for knowing when an account’s Account Receivables went 

above 30, 60, or 90 days. 
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4. Get your fill handle in Cell P2 and double click the cell to fill down 

through your database. The Formula and results are displayed at right. 

5. Now, let’s use years 

– Change your 

formula to read: 

=(TODAY()-

Q2)/365.25.  Your 

information is 

expressed in years, 

but Excel rounds! 

6. Notes on the Formula: 

This formula uses the TODAY() function which is the date on your computer and measures your 

calculation in days.  If you do not put in the 365.25 division, this will calculate the number of 

days that the person has been alive not in years.  This is depressing for someone as old as I am so 

I care not to use the days – the years are bad enough! The .25 in the 365.25 figure is for leap 

years. 

7. You will need to decrease your number of decimal places and if you 

decrease to no decimal places, Excel will round up and we don’t like 

that especially my female friends and clients – I don’t appreciate this 

either! 

8. You may use the YEAR Function as well to calculate in Years. Rounding 

is not an issue, since this function expresses whole years; however, 

many organizations like having at least one or two digits for age or 

service. Your Formula looks like this =YEAR(TODAY())-YEAR(N2). We’ll 

use the YEAR function to calculate the Age at Hire.  

9. Here’s how to use the ROUNDDOWN function.  

10. Click in Cell V2 and edit 

the formula to read:  
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11. =ROUNDDOWN(((TODAY()-Q2)/365.25),0) 

12. This will accomplish exactly what you want.  The number o 

fparentheses can be tricky and the 0 is the number of decimal places 

that you want. 

13. If you like this you may use your fill handle to overwrite your 

existing formulas in the column. 

 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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Now, let’s calculate the Age at which the associate was hired.  With this formula we won’t use 

the TODAY() function but we will compare two dates and use the YEAR Function.  For us the 

dates will be the Birth Date and the Hire date. 

1. With your Personnel File Workbook open, 

Click in Cell W2.  

2. Enter this formula =YEAR(U2)-YEAR(Q2) 

3. Use your Fill Handle to copy the formula 

down through your column. 

4. This provides the Age at Hire and the time 

interval in years. 

Next, with Length of Service, let’s have the ability to show partial 

years.  As a Human Resources Manager, I needed to know parts of years rather than whole 

years. 

1. In Cell X2, Enter the Formula =(TODAY()-OU)/365.25 

2. You may need to decrease or increase 

your decimal places as you like. 

3. Use your Fill Handle to copy this formula 

in your remaining cells. 

 As related previously, if you want to compare an Order 

date verses a Ship Date or Purchase date verses an 

Warranty Expiration date you may want to use days or 

months.  

If you like you may use the ROUNDDOWN function has described above.  Also, when you 

change a Birth Date or Hire Date your calculations change too. 

There are other functions to check out too.  You may use the NETWORKDAYS to measure 

Workdays rather than including Weekends.   You may want to use the MONTH function to 

calculate based on months.  Check this out on Excel’s help with functions. 
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Hey  Ma te !  Le t ’ s  CO NCATEN ATE !  

Concatenation is a fancy word for bring together or consolidate.  The Concatenate function in 

Excel consolidates two or more columns into one column.  For example, you may want your 

First Name and Last Name columns in one column entitled Name or maybe you want your City, 

State, and Zip Code columns as one.  

Hot Tip!  Concatenating columns makes mail merge from 

Word easier and less cumbersome with working with one 

column rather than 2 or 3.  

We’ll use the concatenation function on our Database Functionality file and Concatenate Text 

2 Columns worksheet to consolidate the Last Name and First Name Columns. 

1. Open the Excel Workbook entitled Database Functionality and select 

the Concatenation worksheet/tab. 

2. We’ll insert two columns for our concatenated columns. One Column 

for Name and one column for City, State, and Zip. 

3. Right Click the Column E Header or the Home Street Line 1 column 

and from the shortcut list, click Insert.  A New, Blank column 

inserts to the left for you. 

4. Right Click the Column header K and from the shortcut menu, 

choose Insert.  A New, Blank column inserts to the left for you.  

5. Click Cell E1 and type Name. 

6. Click in Cell K1 and type – City, ST, ZIP 

7. Click the Formulas Tab and the Text 

Command button and choose 

Concatenate from the list.  

8. In the Function Arguments Dialogue box 

for Concatenate enter C2 (by typing the 

cell reference C2 or clicking the cell C2) 

in the Text 1 box. 

9. In the Text2 box enter D2 (by click the 

cell D2 or typing D2). 
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10. Excel displays that the function is working for you. 

11. Click OK. 

This is fine, except we want a space between the First Name and the Last Name, so we will 

need to edit the function. 

1. Click in your formula bar 

and edit the formula as 

displayed at right. 

2. We accomplish this by 

typing a quotation mark, pressing our spacebar, typing another 

quotation mark, and typing a comma. 

3. The function now reads =CONCATENATE(C2,” “,D2) and the name has 

a space in it. 

4. Finally, double click your fill handle in Cell E2 to copy this function 

through your list. 

Now, let’s edit the function so our names will be by Last Name and then First Name with a 

comma separating them. 

1. Click in Cell E2 and in the formula bar 

edit the function as follows: 

2. Change C to D in the first cell 

reference (so cell D2 is the first cell 

reference.) 

3. Type a comma after the quotation mark and before the space. 

4. Change D to C in the second cell reference (so cell C2 is the second cell 

reference.) 

5. Press enter and double click your fill handle in cell E2 to copy this 

function through your list. 

6. Finally, click the Sort Ascending icon to automatically sort your list by 

Last Name and then by First Name. 

So our Concatenate function aids in formatting, functionality, and in sorting.  You may need to 

widen your columns to view your data. 
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Now, let’s practice concatenation with our City, State, and ZIP code columns in the inserted 

K2 cell. 

1. Click in cell K2. 

2. Activate your Insert Function Dialogue box 

and from the Categories insure Text appears 

and select the Concatenate Function from 

your list. 

3. The Function Arguments dialogues box 

appears and in the Text1 box type or click cell 

H2, 

4. In the Text2 box type or click cell I2, 

5. And finally in the Text3 box type or click cell J2, as pictured at right for 

you. 

6. Click OK. 

7. The text runs together and as in our previous exercise we want 

additional spaces and a 

comma to separate our text. 

8. Edit the function as it appears 

at right by inserting the 

quotation marks, comma, and 

spaces. The function should 

read:  

=CONCATENATE(H2,”, “,I2,” “,J2). 

9. Finally, double click your fill handle 

in cell K2 to fill this down through 

your list. You may need to widen 

your columns to see your 

concatenated information. 

Your city, state, and ZIP Code have appropriate 

spacing now for a mail merge or other use. 

If you prefer to use the Function Arguments 

dialogue box the screen at right displays how you 

would need to set the function for the First and Last 

Name columns; I prefer editing the function directly. 
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Looko u t  fo r  Look Ups  

Using Excel as a List or Database tracking system allows the program to populate information 

from another area of a worksheet or from an entirely different worksheet.  This can eliminate 

duplicate input and can quickly locate specific information for you based upon criteria.  While 

there is a Lookup function that will lookup one row or one column of data the VLOOKUP and 

HLOOKUP functions are more powerful and popular because they can use multiple columns and 

rows. 

 

If your worksheet is a vertical type of worksheet, that is where the data is in columns use the 

VLOOKUP (Vertical Lookup) Function.  If your worksheet is a horizontal type of worksheet, 

that is where the data is in rows use the HLOOKUP (Horizontal Lookup) function.  The Vertical 

Lookup function will lookup information in columns; the Horizontal Lookup function will 

lookup information in rows.  We will use the Vertical Lookup (VLOOKUP Function). 

 

The ExcelVLlookup workbook contains a vertical lookup for us to examine. 

1. Open the ExcelVlookup file. Click on the Product Sales sheet, notice 

the figures in the Date column – these numbers are retrieved from 

the individual sheets.  Navigate to the August 1 tab and change a 

number for a Product – click back on the Product Sales sheet and 

notice the number updates automatically.  VLookup automatically 

updates a cell from another worksheet.   

2. Where you see a blank or #N/A the product code doesn’t exist on the 

other worksheets. Great for comparing worksheets and the missing 

data – this is popular for audits and reconciliation activities and a 

host of other needs when comparing the differences between 

worksheets or to populate and update a worksheet based on another 

worksheet. 

 

The Product Sales worksheet retrieves its information from the other worksheets.  Each day a 

worksheet downloads from a server illustrating the Product Code sales for each day.  As a day is 

added as a worksheet, the Product Sales worksheet needs to have a column added and the 

vertical lookup function modified to reflect the additional daily sales.  Of course, in the “real 
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world” you would copy the VLOOKUP function and edit it; however, for our exercise we will 

develop a new Vertical Lookup function.  The Product Sales worksheet “looks” at the other 

worksheets and compares the Product Code and based upon the Product Code the value in 

Column B is returned. 

 

 Hot Tip! This is another area in which using a Named data 

range is very helpful; otherwise, you may need to use 

Absolute Reference using the $ signs.  I encourage you to 

name your area to reduce frustration and mistakes. I will use 

the name Aug2Sales for our exercises here.  

 

Here are the steps and our exercise for using Vertical Lookup to retrieve information based 

upon Product Code from another worksheet (August 2). 

1. Open the ExcelVloopup workbook 

and Click the August 2 tab and 

select Columns A & B (this is the 

area from which we retrieve the 

data). In the Name box type 

Aug2Sales and press enter to name 

this area. 

2. Click back in the Product Sales 

worksheet and click in Cell E3 – this 

is where we will construct our 

VLOOKUP function. 

3. Click the Formulas Tab and in the 

Function Library Group click the 

Lookup & Reference item and from 

the menu select VLOOKUP.  The 

VLOOKUP function dialogue box 

activates. 
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4. If your Function Arguments box covers your data, click at the top of 

the dialogue box and move it.  

5. Lookup_value is the column or cell(s) that contain the item you wish 

to have Excel to compare in order to find the data for that item.  In 

our case, the Product Code information is retrieved and this 

information is in Column A. 

6. Click the Column A column header in the Product Sales worksheet, 

7. The Dialogue box displays A:A, 

8. Next, Excel needs the area containing the data.  This is signified by 

the Table_array box.  The Table_array can be a range of cells, 

columns, rows, etc.  We named our area Aug2Sales.   

9. Click and drag Column A and B in the August 2 worksheet or type 

Aug2Sales – Excel places this name in the Table_array box for you. 

10. Excel needs the column number from our table array or data area.  

We will use Column B from our area and Column B happens to be the 

second column in our array.  Type 2 for the Col_index_num.  Press 

Tab. 



Page 102 Excelling at Excel  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 

No Duplication Permitted  404-299-1706 

11. In our worksheet we need an EXACT or precise match for the data 

since we have specific product codes; therefore, type FALSE in our 

last row. 

12. Click OK. 

13. Finally, using the ever popular Fill Handle, click the in cell E3 and 

double click the AutoFill Handle to fill the remaining cells.  

14. Click on the August 2 tab and at the bottom of the product list add 

10102 and in the second column type a number. Click back on your 

Product Sales worksheet - your information automatically populates. 

  Note:  If Excel does not find a match it populates the worksheet with N/A. 

Let’s practice another Vertical Lookup.  This time we will enter a product code in one cell and 

the sales for that product code will display in another cell. 

1. Click the August 1 worksheet. 

2. Notice cells D1 through E2,  

3. In cell E1 type 10400, 

4. Cell E2 displays 12, 

5. Scroll down your worksheet to the Product code of 10400 and notice 

that Excel is displaying the correct number.  Change the cell from 12 

to 15. 

6. Scroll back to the top of your worksheet, notice E2 displays 15. 

Let’s add this “function”ality to our August 2 worksheet. 

1. Click the August 2 worksheet, 

2. Click cell E1 and enter 10101, 

3. Click cell E2, 

4. Click Formulas Tab and click the Recently 

Used button and from the menu choose 

VLOOKUP. 

5. The lookup value is cell E1 – either type E1 or using the collapse icon, 

click cell E1.  

6. In the Table_array box type Aug2Sales or click and drag Columns A 

and B  (The name of our range of cells containing our lookup data), 
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7. The Col_index_num is 2, 

8. The Range_lookup is False, 

9. Click OK, 

10. In cell E1 enter another Product Code and notice the changes in Cell 

E2. 

This is popular in using a huge worksheet to display specific information and is much quicker 

than using the Find feature and using the Filter items. We will use the VLOOKUP function in the 

same manner in our next section, but we will have more columns.  

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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I f Error  Fun c t ion  

Excel will put #N/A if a value is not found in the Lookup.  You may not want Excel to display 

this and display nothing or other text.  Excel’s new IFERROR Function allows you to specify 

the error display.   

Here’s how to use the IFERROR function. 

1. In your VLookup workbook and the Product Sales worksheet, Click cell 

E3 with your VLookup Function. Edit the function and add the IFERROR 

Function like this:  

=IFERROR(VLOOKUP(A:A,Aug2Sales,2,FALSE),””).   

2. Fill down your edited function by double clicking your Fill Handle for 

this cell or clicking and dragging down to the end of your list.  Excel 

replaces the #N/A with a blank because we used double quotation 

marks in our IFERROR function. 

 

You can put words or other characters between the quotation marks to 

further customize your error message as displayed below after editing my 

VLOOKUP on the August 2 tab.   

While you may use the Function Arguments box to accomplish the IFERROR function I have 

found that the Function Arguments become the Function Cursing box for me as I find it easier to 

edit using the formula bar than the dialogue box. 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________  



Greg Creech Excelling at Excel  Page 105 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

 

 

Co nd i t io na l  Fo rma t t ing  

Excel has a feature that allows you to have cells formatted in a particular manner when a value 

or range of values is present.  This feature is aptly called Conditional Formatting.  I have used 

Conditional Formatting to color code cells based on a value for several companies.  Here are a 

few example of how I have used Conditional Formatting to help my clients. 

 

✓ Color Code cells based on ZIP codes for an Insurance company that needed to have high 

accident ZIP codes in one color, medium accident zone ZIP Codes in another color and 

finally low accident zones ZIP codes in another color. 

✓ A telecommunications company used color coding for date ranges to alert them when 

orders were due and overdue.  

✓ As a Human Resources Manager I used Conditional Formatting for attainment 

percentages and to color code highly, medium, and lowly ranked associates.  

 

For our example, we will want to color code our difference Columns in order to take money from 

one category that is under budget and give money to other items that are over budget.  We will 

color code our Difference columns so at a glance we will know which items we can take money 

from and those that we need to leave as is. Then, we’ll use some of Conditional Formatting’s 

built in functionality for percentages and number values. 

 

Custom Conditional Formatting  
Here are the steps to have our numbers in the Differences columns formatted based upon a 

value in the cell. 

1. Have your Budget Workbook open, 

2. Click on the Forecast tab, 

3. Select Cell D5 through D14 through click and drag. 

4. Press your CTRL key and Keep it pressed. 

5. Click and drag Cell G5 through G14. 

6. Release your mouse button and release the CTRL key. 
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7. Our two areas are selected that we want to 

use Conditional Formatting. 

8. On the Home Tab, Click the Conditional 

Formatting command button,  

9. From the Cascading menu, Click the 

Highlight Cells Rules and Choose the 

Greater than . . . item. 

10. The Greater Than box opens for you 

to format your cells. Using the drop down 

arrow in the with box look at some of the 

effects Excel Provides. 

11. Click the Custom Format. . . Item. 

12. The familiar Format Cells dialogue 

box opens; however, not all items are 

available but you may change your Font 

Style and Color as well as provide a border 

and fill color and pattern. 

13. As pictured at right, we will change our 

dialogue box to reflect the values and range 

of values with specific colors. 

14. Change your font to bold and change the font color 

for values that are greater than 250. 

15. Click the Fill tab and give your cell a fill color – I chose 

yellow. 

16. Click OK. Click OK, again, at the Greater Than box. 

17. Your formatting changes for cells greater than 250.  

Let’s add another rule and learn to edit and add new rules. 

1. With your area D5 through D14 and G5 through G14 still 

selected in the Budget workbook and Forecast Tab,  

2. Click the Conditional Formatting Command Button, Click the 

Manage Rules item at the bottom of the menu. 
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My completed rules and formatting appear at right. 

Your screen will have the rule you previously applied to 

this area.  You can create, edit, and delete rules from this 

location and also change the area you want to set rules 

for using the Show Formatting rules for: area.  

1. Click the New Rule. . . button. 

2. At the New Formatting Rule Pane, 

choose the Format only cells that contain 

item. 

3. In the Edit the Rule Description: area 

change your Cell Value to be less than 

and your value to be 0 as pictured at 

right. 

4. Click the Format button, 

5. In the Format Cells dialogue box choose 

Bold and a color and on the fill tab 

choose a fill color if you like. 

6. Click OK. 

7. At the New Formatting Rule pane, Click 

OK. 

8. Your negative values change color and 

fill. 
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Now, using these steps as a guide create your own rule and formatting for values 0 – 250 for 

cells 

D5 through D14 and G5 through G14.  

 

You have your personal or professional monthly budget and expense tracking system in place!  

Now, all you have to do is remember to use it. 

 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Automatic Conditional Formatting  

Excel has many terrific built in Conditional Formats that provides magic for your numbers and 

percentages.  Excel can rank your values in neat and easy ways.  

We’ll look at these ways of using Excel’s Automatic Conditional 

Formatting.   The 2007/2010 built in Conditional Formatting 

that we will learn here will not convert to previous versions of 

Excel. If you save your file as a 97-2003 format the screen at 

right should appear and when it says Significant loss of 

functionality – Believe IT.  

1. First, Open a file entitled Database 

Functionality.xlsm, 

2. Click the Conditional Format Personnel tab, 

3. Select Cells M2 through M48 or select the entire column by clicking 

the Column Header M, 

4. Click the Conditional Formatting button and from the menu look at 

the various styles.  I have several of these styles for my percentages 

displayed below. 
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5.  I have the Data Bars in Blue, then the Color Scales, and finally, the 

Icon sets. The Ratings are cool, too. Select the formatting you would 

like.  

 A Hot Tip!  You can apply more than one of the built in 

formatting rules to your cells.   

For practice select the Bonus cells of N2 through N48 (or Click column header 

N to select the entire column) and using the Conditional Formatting button 

and menu select a format for your bonus ranges. 

Save your workbook. 

On your own use Conditional Formatting for the Age column.  Also, notice the Clear Rules that 

you may use to remove Conditional Formatting and similar to the Top 10 Filter we used earlier, 

Conditional Formatting can format your information based on the top or bottom items and 

above or below averages and other types of numerical data for you. Practice using difference 

rules for your numbers and dates.  At the bottom of this page, I have used Top 10 for Age and a 

green fill then I sorted the information from Largest to Smallest. 
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Tex t  t o  Co lu mns  –  Back wa rd  Conca ten a t io n  

Many Excel databases or data imported into Excel may be in one column with a space, tab, 

comma, or other character separating the information.  You may want to have the items separate 

columns to help you with filtering, sorting, or performing other Excel functionality.  Excel 

provides the Text to Columns feature under the Data Tab.  We’ll split a name column separated 

by a space into two separate columns. 

 

 An Important Gotcha! Please make sure that you have sufficient columns and areas for 

your Text to Columns to fit.  Otherwise, Excel may overwrite existing data in your 

worksheet that you want to retain.  

 

1. Open the Database Functionality File workbook and Click the Text 2 

Columns Tab 

2. We will split the Name column into two columns for Last Name and 

First Name. Then we will split a date into three columns 

First we will need two columns to put our split data in. 

3. Select Columns D and E. 

4. Right click on one of the column headers and select insert.  Excel 

inserts two new columns for you. 

5. Select cells C2 through C47 and copy these cells and paste them in D2 

through D47.  We accomplish this so we 

may preserve the current column with the 

Last and First Name; otherwise, after we 

split the data, Excel will make this the first 

name column and overwrite our 

information. 

6. Select D2 through D47. 

7. Click your Data Tab and click the Text to 

Columns button. Your Convert Text to 

Columns Wizard activates at Step 1 of 3. 
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8. Ensure Delimited is chosen because our data 

is separated by a Comma. 

9. Click Next.  

10. At Step 2, Check Comma and uncheck 

any other Delimiters boxes that may be 

checked, such a Tab. 

11. Click Next. 

12. At Step 3, Click the Column header that 

says General in the Data preview screen and 

then Click Text in the Column data format.  

Accomplish this for each column.  

13. After changing your Columns to Text, 

Click Finish.  

 

 

14. Next Excel will prompt you to replace 

the contents of the destination cells – this is 

why we inserted two blank columns at the 

beginning of the exercise, so we would not 

overwrite existing data in the columns. 

15. Click OK. 

16. Click cell D1 and type Last Name. 

17. Click cell E1 and  type First Name 

Your data is now in two separate columns and your original 

column is still intact. 
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Tex t  t o  Co lu mns  fo r  Da te s  

Separating dates, phone numbers, and other types for formats and data is popular in Excel.  We 

will separate the Birth Date into Months, Days, and Years using the Text to Columns button. 

 

1. Open the Database Functionality Workbook and Click the Text 2 

Columns worksheet. 

2. Insert three columns after the Birth Date Column. 

3. Name these columns Month, Day, and Year – these should be columns 

R, S, and T after we created our Last Name and First Name columns in 

the previous section. 

4. Copy and Paste the birth date range 

from Q2:Q47 to R2:R47 – we want to 

keep our birth date information in tact. 

5. Select P2:P47. 

6. Click the Data tab and the Text to 

Columns button. The Convert Text to 

Columns Wizard activates at step 1. 

7. Ensure that Delimited is selected and 

Click Next. 

8. At Step 2, Click other for our Delimiter 

and enter the /.  Our date separates in 

the Preview box. Uncheck Comma or 

any other checkmarks. 

9. Click Next. 
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10. At Step 3, Change the Column data 

format to Text; otherwise, your number will 

appear as a short date format.   

11. Click Finish. 

12. Since we are replacing empty cells, 

click OK at the Destination cells dialogue 

box. 

 

 

 

 

 

 

 

 

Your dates are separated into different columns. As 

displayed at right, you will want to change the format to 

Number.  Select the cells and right click on the Error button 

and from the menu choose Convert to Number.   You should 

accomplish this for Month, Day, and Year Columns. 

 

 

 

 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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Flash Fil l  –  Excel Magic  

Excel 2013/2016 has a great, new Fill called Flash Fill. Here are some 

of the reasons for and how-to use Flash Fill: 

✓ Completes series for you – Combines AutoComplete and Text-to-Columns features for 

you with the magic of Fill, 

✓ Reduces the need to use the LEFT and RIGHT Functions, 

✓ Great for text, text as numbers, dates, and so on, 

✓ Insert a column, enter a couple of items, and Excel produces a “gray” list of items it 

believes you want to use – press enter to accept the Flash Fill, 

✓ Use the Fill Handle to produce the Flash Fill option in the Fill Handle options for your 

list. 

You may need to format the column as text, number, date, etc. 

 

We’ll use Flash Fill to separate names, dates, and numbers. 

1. With the Database Functionality file open, navigate to 
the Flash Fill tab, 

2. Insert a column after the ZIP code column and give the 
column a heading of Last Name,  

3. In the cell beneath, type Frogg, Press Enter, 
4. In the next cell (I3) begin to type Smith, 
5. Excel magically “sees” your Name list and provides a list 

of the other last names appearing in gray, 
6. Press enter and your last names appear. Pressing enter 

accepts the Flash fill. 
 

7. Next, insert a column after Last Name and give it a 
heading of First Name, 

8. In the cell beneath, type Kermitt, Press Enter 
9. Type Janis and, again, the magic of Flash Fill picks up 

the First Name, 
10. Press enter to accept Flash Fill 

New for 2013/2016 

 



Greg Creech Excelling at Excel  Page 117 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

 
Now, let’s separate the last four digits of the Social Security Number.  

1. Insert a column wherever you like, give the column 
heading 4 Digits, 

2. In the cell beneath, type 0011, 
3. Notice Excel drops the leading zeros, Change the 

column format to Text and Excel should bring back the 
leading zeros,  

4. In the cell beneath, type 7899, 
5. Flash fill should display the remaining last four digits of 

the SSN, 
6. Press Enter to accept the Flash Fill.  

 You may need to adjust your formatting to General, Text, Date, 

Number, etc. for Fill to work for you.  Also, if Flash Fill doesn’t 

recognize your series or list, you may need to use the Fill Options menu 

and click Flash Fill as displayed here and used in the next exercise.  

Now, let separate a date. 

1. Insert three columns after the Birth Date column. Create 
column headings of Month, Day, and Year.  

2. In the cell beneath Month, type 1.  
3. Notice Excel uses a Date format, select your three 

columns and change the format to a Number and 
decrease your decimal place to none. 

4. Next type a 1 in the cells beneath your 1 in the top cell. 
Excel may not recognize your fill pattern. I typed until a 
reached 2 and used fill. 

5. Fill the information any way with an incorrect Fill and 
with the Fill Options click Flash Fill and viola, Flash fill 
recognizes your birth month.  

6. Now, accomplish the same for the day and year columns 
following the steps above for month. 

 
Enjoy Flash Fill! 
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Forget the Twist,  Let’s  Pivot!  

Pivo tTab les  O verv i ew  

When you use Excel as a tracking system or database, you can have a tremendous amount of 

data in thousands of rows and hundreds of columns.  PivotTables are increasing in popularity 

during this data age and information overload.  Summarizing the data and reviewing key 

components of the worksheet can be difficult.  PivotTables in Excel create summaries for you 

based upon items that you select; PivotTables allow you to manipulate a few fields of 

information and work best when using 1 or 2 fields as data fields; however, you may use many 

fields for calculations sub-totals, totals, and other functions.  PivotTables creates totals, averages 

and other functions for you easily.  PivotTables will automatically sort your data, too.  One of 

the reasons these types of worksheets are called PivotTables is you can move your field of 

information around and quickly change your view of your data as we will learn. The trick is to 

have your spreadsheet in a list format with one row being your fields names and the remaining 

rows being your data records, as we have discussed before.  PivotTables and PivotCharts are 

powerful and not that difficult: however, they can be confusing until you practice them and know 

the data you are using.  We will use the Track.xlsx and the Database Funtioanlity.xlsm 

workbooks to create PivotTables.   

While we will use Excel as our database for our PivotTables, you can use external databases, 

such as SQL and Access.  You will need to update your PivotTables through the Refresh 

command when your data changes no matter where your database resides.  You may need to 

change your data area, too, if you add or delete rows/columns of data. Almost in analytical 

position will require that you know PivotTables. 

Briefly here are the reasons to use PivotTables: 

✓ Summarize fields of information, 

✓ Creates a worksheet “within” a worksheet, 

✓ Uses only a few fields for calculations, 

✓ Automatically sorts your information, 

✓ Easily applies functions, such as Count, Sum, Average, and Standard Deviation, 

✓ Allows you to change your view of your data, 
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✓ Simplifies huge worksheets, 

✓ Automatically creates totals, 

✓ And the list goes on and on. 

 

Get ready, Let’s Pivot again and again. 

 

Pivo tTab les  

PivotTable –  Sales/Revenue Tracking Analysis  

1. Open Track.xlsx. 

2. Click on the Jan Tab. 

3. Click inside of the list below the Customer heading or 

anywhere in the list. 

4. Click the Insert Tab, 

5. Click the PivotTable Button, 

6. Trace down and Choose PivotTable. 

7. At the Create PivotTable Screen, 

ensure Select a table or range is 

selected and the Table/Range has 

Jan!$A$7:$J$95 in it.  I named this 

area JanOrders and could have used 

the range name instead. You could 

use External data sources, such as 

Microsoft’s® Access®  or other 

database applications to create 

PivotTables, by clicking the 

connection to that database or 

external source.   

8. Click New Worksheet for “Choose where you want the PivotTable 

report to be place”. 

9. I like putting my PivotTables on a separate worksheet to have more 

room and visibility than with an Existing Worksheet; however, you 
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may want your information within the worksheet or list that you are 

using, especially for small amounts data and fields.  

10. Click OK. 

Excel should display your PivotTable (ready for us to add fields), and our PivotTable Field List 

Pane with the Areas for our PivotTable below the Field List. 

 

Let’s add items to use on our PivotTable. 

1. Click the Customer field check box and your customer’s appear as 

rows and sorted alphabetically for you..   

2. Click the Date Field and Drag and Drop the field in the area that says 

Column Labels.   

3. Click the Totals button and Drag and Drop it on the Value Items area. 
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My PivotTable appears here. Sometimes if you do not click and drag your field, but simply click 

the field, Excel may not place the field in the row, column, or value setting where you wish.  

Also, Excel may use the wrong function such as Count when you want Sum, but PivotTables 

make changing functions quick and easy (I promise). Notice Excel has quickly created a two 

dimensional worksheet adding my information in rows (Customers) and columns (Dates) and 

created Grand Totals for each of these fields.  If you want to hide your field list to see more of 

your PivotTable click the Field List button in the Show Group to turn off your Field List Pane.  

But, remember to turn it back on to add functions and to Pivot your information. 

Now, is a great time for Freeze Panes.   
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Let’s use a feature that we learned and Freeze our sheet so we can see our 

customers as we scroll to the right and our dates as we scroll downward. 

1. Click cell B5 or the first data cell in your PivotTable, 

2. On the View Tab, Click Freeze Panes button and freeze 

your sheet at Cell B5. You may use your Freeze Pane 

button on your Quick Access Toolbar, too. 

3. Scroll over the end of your PivotTable  to view the Grand 

Total by Customer. 

4. Scroll down to the end of your PivotTable to view the 

Grand Total by Date. 

5. Isn’t this nice?  We didn’t’ have to put in functions for 

these calculations and the items are sorted for us by 

date and alphabetically by customer. 

There we have created our first PivotTable. Basically, all we had to do was click 

and then click and drag our fields and Excel did the analytical magic and 

summations for us. 

 

☺ I have pivoted since the early 1990’s. I pivoted before Pivot was cool.  Microsoft’s Excel has 

“come a long way baby” in the ability to quickly and easily analyze huge amounts of data.  Trust 

me, Pivot Table, have not always been this easy but Microsoft has done a fantastic job of making 

sense out of tons of data. One of the great improvements with Office 2007/2010 are the beautiful 

designs you can use for your data.  So, we can use our analytical part of our brain and we can use 

the creative part of our brain; all in one with PivotTables. ☺ 
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Let’s Format our PivotTable using the Design tab under the PivotTables Tools. 

1. Click inside of your PivotTable and Click the Design Tab. 

2. Using the PivotTable Styles choose a style from the Gallery. There are 

many lovely PivotTable Styles you may choose from your Gallery. 

Your Office Theme determines the PivotTable Styles you will view and 

use.  I am using the Office Theme as we examined earlier. 

3. Next Band your Rows and your Columns using the check boxes on the 

PivotTable Style Options Group. Next, decide if you like Rows or 

Columns or both. 

  

 Remember you must be in a PivotTable to Receive the Tabs for PivotTable Tools. When 

you click away from your PivotTable the tabs disappear. Also, if you Hide your Field List 

pane, remember to click the Field List button on your Show group. 
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PivotTables Options Tab is another important tab for PivotTables. 

We will use Options tab in the PivotTable Tools a lot as we work with 

our PivotTables some, but not all,  of the important commands and 

groups that we will work with are described here. 

PivotTable – This Group provides the ability to quickly name your 

PivotTable and to look at the Options for your PivotTable. The 

PivotTable Options’ first Tab of Layout & Format appears at right. I 

have changed my PivotTable Name to Order Analysis. 

Active Field -  This helps you know in which area of the PivotTable you 

are working for formatting and other actions. 

Sort and Filter – We will use the Sort and Filter settings much like our 

previous work on Sorting and Filter.  Office 2010 contains the new 

Slicer option for Filter which we will use. 

Data – If you make a change to your worksheet, the PivotTable does not automatically update!  

You will need to click the Refresh Button to update your PivotTable with new or changed data 

from the worksheet that the PivotTable is based. Also, if the area of your database/table changes, 

such as adding and deleting rows and columns, you may need to change your Change Data 

Source button.  We will use both of these buttons in future exercises. 

PivotChart – This will create a quick PivotChart based upon your PivotTable – This too saves a 

lot of time and frustration. 

Show – You can quickly Show or Hide your PivotTable Field Last pane by clicking the Field 

List Button. If you have more than 2 or 3 items that you are calculating you can hide the entire 

field but continue to have the field calculated for you using this button.  You can hide or show 

your Expand and Collapse buttons (+ and -) for your data and hide your Field Headers using this 

important group.  

Calculations  – We will add calculations for percentages and change our functions from Sum to 

Average using this new Group.  
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Now, that we are familiar with our PivotTable Options tab, let’s put it to use and 

learn more about PivotTables.  First, let’s format our numbers as currency. 

1. Click in your PivotTable in the Data area,  

2. Right Click a cell and notice all of the neat shortcuts plus the 

Mini Toolbar appears for you to use formatting. Choose Number 

Format as displayed at right. 

3. Our familiar Format Cells dialogue box opens. 

4. Then select Currency, 0 decimal places, and the $ sign. 

5. Click OK to close the Format Cells Dialogue box.  

6. Our numbers are formatted correctly.  Using the 

Number format changes the entire field not a 

select cell or group of cells. 

 

Let’s add another function to our PivotTable and learn how to Pivot 

our data. 

1. With your Field List pane active, Click and Drag 

Total to your Value Area, again. 

2. You will have two Sum of Total. 

3. Click the Sum of Total2 Field and click Arrow to display your 

Value Field Settings from the, shortcut menu as displayed at 

right. 

4. Change the Summarize value field by: to Average, and change 

the name to Average of Total, 

5. Click the Number Format. . . button, 

6. Format the Number as Currency, with 0 decimal 

places. 

7. Click OK. 

8. Click OK again. 

9. Excel adds the Average function to my Dates 

column. 
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10. You can click and drag the Values button from the Column Labels 

area into the Row Labels area as displayed below. This will provide 

averages for each customer and date in rows rather than columns. This 

is a Pivot! You rearrange your view and information by moving the 

items around that is where PivotTables get their name. 

11. Scroll down to the Grand Total area to see your Sum and Average 

by Date and by Customer. 

12. I changed my Row Labels cell to Customer by typing over the 

text and I change my Column Labels cell to Order date by typing over 

the text. 

Wow!  Sure beats manually putting calculations and functions in these areas 

doesn’t it! 
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 Let’s remove the Date field to view only the customer’s totals and averages. Then we 

will add the Date field back to our PivotTable. 

1. Click your Date check box on your field list and the date field 

deletes from your table. 

2. Also, You may click the Date button and drag it out of your 

Column value area a big X will denote that you are removing 

the field OR you may right click on the Date button in the 

value list and from the shortcut menu choose Remove field as 

pictured at right.  

 

3. Now, your PivotTable has grouped all of your Customers 

together with one grand total for Sum and Average with a 

portion of my PivotTable displayed at right. 

 

4. Click in a Sum of Total cell and Click your Sort Largest to 

Smallest Sort button on the Options tab. Excel performs 

your magic sort for you. 

 

5. Click in a Customer name cell and Click sort A to Z to 

alphabetize your customers again. 

6. Click the Date check box on your field list to add the Date 

field  back, 

7. Notice how Excel has 

the Dates below the 

Customer now and 

added the Date field 

to the Row Labels 

area. That’s why they 

are called 

PivotTables to have 

the ability to change 

your view and 

calculations by switching your rows and columns.
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Notice how Excel has a small minus sign before 

each customer – this is the collapse button – click 

this for one of the customers and the date 

information hides from you. Excel now places a plus 

(+) in front of the customer this is an Expand 

button. Click and your Date information returns.  

8. Right Click on a Customer and from the shortcut 

menu trace to Expand/Collapse and from the 

cascading menu select Collapse Entire Field. 

9. Excel again only displays your Customer’s total and 

average. 

10. Right Click on a Customer and from the shortcut menu trace to 

Expand/Collapse and from the cascading menu select Expand Entire 

field and your detail returns. Using these buttons and 

Expand/Collapse options are terrific with lots of complex PivotTable 

that summarizes massive amounts of data. 

Time to Pivot, again! 

1. As displayed here, Click your Customer Field and drag it to the 

Column Labels area. 

2. Click the Date buttons and drag this field to your row labels.  

3. Change your row and column label cells – i.e. Customer and Order 

Date they won’t match your Pivoted data.  

There we have pivoted; we should charge extra for table dancing! 
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Practice pivoting your data in other ways and adding fields, etc. 

 A Hot Tip! Any cell with a number or other data that you 

want to view the details simply double click in cell and Excel 

creates a separate worksheet for that data!  This is a terrific 

feature of any PivotTable.  Try it -  double click a Grand Total 

cell and quickly Excel displays a new worksheet with the data 

that the calculation or number is based.  

A Refreshing Experience  

 An Important Gotcha! As I related in our PivotTable Toolbar overview, unlike Charts 

and other features of Excel, if you change your worksheet data or if your external database 

information changes you will need to refresh your PivotTable by the Refresh command 

button or using the PivotTable Drop down menu.  The Command button menu and 

PivotTable shortcut are displayed below.  Trust me, don’t make the mistake I did for Vice-

President of company when she changed figures on a worksheet and I assumed the 

PivotTable changed too!  Bad assumption and poor job performance – that’s a horrible 

mix.  Aside from that PivotTables are excellent!  

Let’s change our worksheet and Refresh our data. 

1. Click in your Jan worksheet. 

2. For Order 101, Jan 2, and A. B. C. Co. change Word 

to be 100 your total changes to $5,000. 

3. Click your PivotTable Sheet (Mine is Sheet1) 

4. Notice that the Total for A. B. C. Co. doesn’t 

change for Jan and still displays $500. 

5. Click your Refresh icon on the PivotTable Options 

tab. 

6. From your cascading menu choose Refresh All. 

7. Your data is updated with the new amount. 

8. Rename your Sheet to Pivot Table Order Analysis. 

9. Save your Workbook.  
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Changing your Data Source  

Remembering to update your PivotTables when the data changes is important and if you add or 

delete rows or columns from your data source you will need to change your 

data source to reflect the new area.  Sometime the Refresh button will work 

great, sometimes not – better safe than sorry. Also, if you use an external 

data source or database, you will need to change the data source as well and 

refresh your data.  If you use the Name Manager to reference a data source, 

you will need to change the area for your Name Manager on the original 

workbook and then update your PivotTable through refresh. Therefore, when 

you use the Name Manager and a name range, you only 

need to refresh your data in the PivotTable.  If you use an 

existing worksheet and add or delete rows or columns AND 

Refresh button doesn’t work, the  you will need to change 

the data source to reflect your additions and/or deletions.  

I am changing my data source to reflect the Range name of 

my database rather than the area of the data source.  

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Report Filter Pages 

You can create a different page or worksheet for each Customer by moving the customer 

button to the Page Area of the PivotTable.  You will get a drop down box and have the ability 

to view individual customers and the Dates and dollar amounts rather than viewing all 

customers. I have used this feature for my clients to generate invoices for their clients, I have 

created compensation worksheets for sales people using the Report Filter, and there are many 

uses for this neat feature in PivotTables. This acts the same as using our AutoFilter feature.  

Let’s look at the Report Filter Pages feature of a PivotTable. 

1. Click the Customer button and drag it to your Report Filter area of 

your pivot selection. I have my Values as Rows and my Date field as 

Columns.  In Cell B1 our (All) cell for Report Filter, click the Drop 

Down Arrow and a Pick List will appear for you to choose a customer 

to view in your Report Filter.  

2. Click a customer and Click OK. 

3. Only that specific customer’s information will display.  

4. Display A.B.C. and other customer using this feature.  Don’t forget to 

click OK after selecting your customer.  
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5. Notice the Select Multiple Items in your Filter list.  I 

have checked this box and then checked the boxes for 

several customers.  Bates Motel, Computer Tech, and 

Georgy Porgy are merging into a corporate empire and 

I am choosing those clients and clicking OK to view 

how I need to reallocate my resources and determine 

the revenue and other important business analysis 

when a merger of this magnitude occurs. 

6. Excel displays the results for these accounts and the 

words (Multiple Items) appear in your Filter box. 

Excel allows you to create a worksheet for each of these pages very efficiently.  I 

have used this to track compensation by salesperson, unit sales by divisions, and 

salary and bonus information by employee as well as many other uses. 

1. Return to your Report Filter list and uncheck the Select 

Multiple Items to view the bottom line results of All of 

your customers. 

2. Click OK. Excel displays your Totals and Averages for all of the 

customers, again. 

3. In the Options Tab and PivotTable Group, click the 

PivotTable Options menu and from the Cascading menu, 

Click Show Report Filter Pages at the menu as pictured at 

right. 
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4. The show pages dialogues box appears with Customer 

selected in the Show all pages of: section.  

5. Click OK.  

Wow!  Excel super-fast creates a worksheet for each customer and names each 

tab the customer’s name.  I wish Excel and I worked so fast in other areas of 

the application. 

This workbook’s file size increases greatly, too! 

1. Click on some of these tabs to view the customer’s information. 

2. As I related I use this all of the time and group these sheets so I can 

print them all at once for my personnel and division’s important and 

confidential information. 

If you had only certain customers displayed, Excel would create worksheets 

only for those customers displayed in your Filter. 

Filter within a PivotTable  

1. Change your PivotTable field so the Customer is Rows, 

the values are in Rows, and the Date is in columns. 

2. Using the Arrow next to your Row Labels circled at right 

(Customer – which I had to rename), Uncheck Select All 

and check the customers you wish to view, I am 

selected Bates Motel, Computer Tech, and Georgy 

Porgy. 

3. Click OK.  

4. The detail results of these clients and Grand Totals 

appear here. 
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1. Return to your January Pivot and practice additional pivots, such as 

displayed at right. I have added Customer to my Values area. 

2. Next, I sorted my information by Sum of Total and now I can make 

decisions about who are my top accounts that I may want to honor 

with a discount or tickets to the Bruce Springsteen concert or World 

Cup/Final Four tickets.  I cannot make these business decisions looking 

at the raw data. I examine the Total billing, Average billing per order, 

and number of orders generating.   

As an Operations Manager, I also reviewed their collections and 30, 60, 90 day results which this 

table/database did not contain to determine the best clients to honor. 

 When you add a text field, Excel correctly assumes (in this 

case) that I want to use the COUNT function.  

3. Save your workbook and thanks for Pivoting. 
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Slice and Dice your Data Information  

Excel 2010 has a terrific new tool to slice your data.  Slicer is a fancy word for 

Interactive Filter. A problem with PivotTables was the ability to quickly and 

easily filter your data with multiple criteria.  For Example, if I wanted Atlanta, 

GA data but not Atlanta, TX or Atlanta, ID and the information was in 

separate fields this was difficult to accomplish in PivotTables.  Now with the 

Insert Slicer button we can have multiple filters based on different criteria.   

Let’s slice and dice our data. 

1. Click in your Track file’s, PivotTable to activate the 

PivotTable and tabs. 

2. On the Options tab and Sort & Filter Group, click the Insert 

Slicer command button. 

3. At the next pane click Customer and Date to select those fields 

with a check mark. 

4. Click OK.  

5. Your Slicer fields for Customer and Date appear with an Option 

Tab for Slicer Tools. I made my panes larger by clicking a 

dragging corner and I used the Slicer Styles to change the color 

of the Slicers’ fields.  

 



Page 136 Excelling at Excel  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 

No Duplication Permitted  404-299-1706 

6. Now, click a customer and notice how Excel displays only that 

customer’s information (which we have accomplished with other 

filters). Next Notice how your Date Slicer only have the dates that is 

associated with the Customer’s data – this we have not accomplished. 

Choose an active date and now you are slicing and dicing your data or 

as I call it Digging for Dollars.  Excel calls this an interactive filter. 

 A Hot Tip! You may press your CTRL (Control) key to select 

data in a field that is not continuous. You may click and drag 

to select contiguous data that you want to view.  I am using 

the CTRL + Click method to select non-contiguous customers 

below.  

7. You may clear your Filter by pressing the Clear Filter button circled 

below for you. 

8. Next select multiple customers by pressing your CTRL (Control) key 

and clicking the customers you wish to view – I have selected Bates 

Motel, Computer Tech, and Georgy Porgy below. Next you may select 

only certain date(s) to view if you like. 

Enjoy Slicing your information. 

 

 Write your notes 

here:_________________________________________________________ 

 

________________________________________________________________________ 

  



Greg Creech Excelling at Excel  Page 137 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Calculations and Percentages  

A nice, new feature of Excel 2010 is the Summarize Views By and Show Values as 

commands. We used the Field Settings Dialogue box and pane to change our 

function, such as from Sum to Average.  You could use the Summarize Views By 

Command button as well which displays at right. Let’s use the Show Values As 

command button to show the percentages of our Grand Totals. 

1. Click in your PivotTable, 

2. Add another Sum function for Total – I clicked and drug the 

Total field from the Field List to below the Count of Customer Value in 

the Values pane. 

3. Click one of the totals in the Sum of Total (2) calculations to select one 

of these calculations. 

4. Click the Show Value as button and from the list click % of Grand Total 

and Excel expresses your calculations quickly as a percentage. My 

PivotTable with the Percent of Total field which I renamed appears 

below.  
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We have used PivotTables for client analysis of Revenue and counting the number of sales we 

made to a customer.  Now, let’s use PivotTables for some Human Resources and Marketing 

analysis. 

PivotTable –  Human Resources and 
Marketing/Demographic Analysis 

As a Human Resources Manager and Marketing Analysis in Corporate America, I used 

PivotTables a lot to analyze information that I downloaded from sales/marketing, personnel or 

HR databases into Excel.  I help my clients with PivotTables and analyzing their marketing, 

sales, operations, and HR data.  One of the world’s largest company’s Human Resources 

department downloaded information into Excel for all new hires, they asked me how they could 

quickly see the number of new hires by department.  Using PivotTables, we answered the 

question within two minutes.  We’ll look at other analysis for departments and a look at 

PivotCharts, too. 

1. Open the workbook Database Functionality.xlsm. 

2. Click the first worksheet, Personnel. 

3. Click in the data area.  I have named the database HRPersonnel which 

refers to the area of 

=Personnel!$A$1:$Z$46.  You may go to 

the Formula Tab and look at all of the 

names I have for this workbook using the 

Name Manager that we learned earlier.  I 

use the name a lot for functions like 

VLookup and If . . . Then, and for 

PivotTables. 

4. Click the Insert Tab and the PivotTable 

button and select PivotTable. 

5. Using the picture at Right change your Create PivotTable items to 

reflect HRPersonnel as your Table/Range and place the PivotTable in 

this worksheet and the location at cell AB1. 

6. Click OK. 
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Now, we will learn how I helped my client to display number of associates for each department. 

1. Using the picture at right, 

Scroll to your AB1 cell or in 

that area and click your 

Options tab for the PivotTables 

Tool. 

2. In your PivotTable Field List 

and Drag the Dept  field to the 

Row Labels area 

3. Click and drag the Last Name 

field to the Values section. 

4. Name your PivotTable Dept 

Analysis using the Name box at 

the top of the Options tab. 

Viola, there we had the number of associates by department with a grand total included. 

 

Now, let’s create a PivotChart to accompany our PivotTable. 
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Pivo tCh ar t  
Here’s how to create PivotChart based on your PivotTable. 

1. Click the PivotChart button on the Options Tab of 

the PivotTables Tools. 

2. Choose a column chart, I am choosing a 

Clustered 3-D column chart. 

 

Excel places a chart on your worksheet.  

1. Click and drag the chart away from your 

PivotTable; I moved mine directly below 

the PivotTable. 

2. Your Tabs change and the Design, Layout, 

and Format tabs plus a new tab Analyze 

appear for your PivotChart.  These are 

the same as we previously learned in 

Charts. 

3. Modify your Row Label and Column 

Label Names and format your Chart 

and other items as we have previously 

learned. 
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Now, let’s look at more analysis. 

1. Click back in your Dept 

Analysis PivotTable 

2. Using the screen at right, add 

the Age and the Bonus fields 

to the Values area. 

3. You’ll need to change your 

Age calculation to Average and 

change the number format to 

Number with no decimal 

places. You may click a 

number in the PivotTable for 

Sum of Age and use your 

Summarize Values By button 

or use your Field Settings to 

change the Sum function for Age to 

Average.  

4. Next, you’ll want to format your 

Bonus to currency or accounting with 

no decimal places using your Field 

Settings and the Number Format 

Button.  

5. If you need help with this, review the 

previous PivotTables we constructed. 

6. Also, your PivotChart changes which 

is good for Bonus information but not 

much good for anything else.  Your 

PivotCharts are based on your 

PivotTables. 

You should practice using PivotTables for others areas 

and calculations. 
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Also, change your formatting using your Design Tab of PivotTable Tools and use conditional 

formatting.  I have included a screen of my completed Dept Analysis PivotTable.  I typed over 

the labels that PivotTable gave and used conditional formatting for the Bonus Total and Average 

Age. Notice I sort from Greatest to Least for my Bonus Total.  

Now, notice the Average Age for HR is 59. What makes up this number? Double click 59 for the 

HR Avg Age and Excel creates a separate new worksheet of the people that make up this 

number.  A partial view of my folks 

appear here. 

 

 

 

 

 

Now, let’s analyze bonus, age, and 

number of people by state, city, and 

zip code.  Next we’ll look at products 

and services for marketing and demographic information.   

1. With your Database Functionality.xlsm workbook and open and in the 

Personnel tab, click in the data table and from the Insert tab click 

Pivot Table.  

2. The Name range to use is HRPersonnel and place the PivotTable in a 

new worksheet. I want to change the position of my Field List Pane 

and the sections to view. 

 

 A Hot Tip! Moving your Field List Pane and changing the 

view of your sections. You may click on your 

PivotTable’s Field List Pane’s Title bar and move it 

into your worksheet. Often the Field List Pane docks 

on the right side of your screen, which generally I 

like, but now I want my field list closer to my data 

and I want to change the position of the sections.  

The Pivot Table Field List Section Pane and Menu 

are displayed at right.  
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3. Using your field list and the 

screenshot at right build your 

PivotTable with the State as rows 

and the functions of: 

✓ Sum of Bonus, 

✓ Average of Age, 

✓ Count of Last Name. 

4. Choose a lovely design for your 

PivotTable and using the Value 

Field Settings pane format your 

numbers as we have accomplished 

in previous sections. 

5. Now, add the Home City field to 

your Row Labels beneath Home 

state. 

6. Finally, add Home Zip below 

your Home City in the Row 

Labels. See how easy 

demographic and marketing 

data is to analyze using a 

PivotTable. 

7. Move the Row Labels of Home 

State, Home City, and Home 

Zip to the Report Filter.  Filter 

for states, cities, and codes. 

8. As pictured here, I am 

viewing the information for Atlanta, 

GA in ZIP 30303- and if I wanted the 

details of these 2 people I can double 

click a number and Excel creates a 

worksheet with the details for me. 
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S l i ce  a nd  D ice ,  ag a in .  

1. Using your PivotTable Options Tab Click the Insert 

Slicer button and from the list choose Home City, 

Home State, and  Home ZIP. Click OK. 

2. Since I had my Report filter on my Slicer reflects 

those items in the Report Filter Pane. Using your 

Slicer Tools and Options menu, change your color of 

the slices and practice choosing different States, 

Cities, and Zip Codes.  For example, I am viewing 

California’s information and I have moved my Report 

Filters back as Row Labels to view the details.  

3. Finally, move your Report Filter Labels back to the Report Filter and 

create a worksheet for each state using the Pivot 

Table Options and the Show Report Filter Pages 

Item. 

4. Choose State from the menu and click OK. Excel 

creates a worksheet for each state. 
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Subtotals Overview 

Just as with PivotTables, Subtotals can calculate data automatically using your database list in 

Excel.  Your data must first be sorted correctly and include your header rows and data row 

records.  We will add Subtotals to our Total amounts in the JAN worksheet. 

 

1. Have Track.xlsm open. 

2. Click in the Jan worksheet. 

3. Click in a cell under the Customer Cell (although all you need to do is 

to click within the list.) 

4. Click the Sort Ascending Icon  

 An Important Gotcha! If your worksheet is not sorted correctly Subtotals 

won’t calculate correctly either.  

1. On the Ribbon, Click the Data Tab, 

2. Click the Subtotal button in the Outline Group at the end 

of the tab. 

3. The Subtotals Dialogue box appears, as Pictured at 

right. 

4. Using the picture at right as a guide, At each 

change in:  Choose customer from the drop down 

box. 

5. Ensure Sum Function is chosen in the Use function.  

6. In the “Add Subtotal to:” section have Total 

Checked. 

7. Click OK. 

Excel creates Subtotals for each customer!  Imagine using a calculator to 

retrieve this information – Like I did once upon a time. 
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 Notice the 1, 2, 3 buttons.  Click 2 and only the Subtotals for your customer will display as 

shown at right. 

 

This is a feature of Group 

and Outline that we will 

study.  The Plus (+) sign 

will expand your view and 

display details.  The Minus 

(-) sign will collapse your 

detail view. Clicking the 3 

button expands everything 

for you. Clicking the 1 

should display your grand 

total. 

1. Click the Plus 

sign (+) by 

Computer Tech 

and you will 

see the details 

for Computer 

Tech.  

2. Click the Minus 

sign (-) to collapse the information. 

 Important Gotcha! Notice the Revenue and Support, Training, and Help figures are 

doubled! The functions include your new subtotals so your figures are 

not correct and are inflated!    

Let’s Remove our Subtotals. 

1. In the Data tab, Click Subtotals, 

2. From the Dialogue box for Subtotals Click the Remove 

All button. 

3. The subtotals are removed. 

I have a client that uses this feature for subtotals  by date for her accounts 

and billing.  The process is the same except her worksheet sorts by date and 

“At each change in” is Date.  Let’s accomplish this. 
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With your subtotals removed, we will add subtotals to provide subtotals by 

date. 

1. First sort your Jan Worksheet by date – Click 

in the Date column and Click the Sort 

Ascending Icon. 

2. On the Data Tab, Click the Subtotals button.  

3. The Subtotals Dialogue box appears, as 

Pictured at right. 

4. Using the picture at right as a guide, At each 

change in:  Choose Date from the drop down 

box. 

5. Ensure Sum Function is chosen in the Use 

function. 

6. In the “Add Subtotal to:” section have Total 

Checked. 

7. Click OK. 

Excel creates Subtotals for 

each Date! 

8. Click the 2 

button circled 

here to display 

the Totals for 

each date.   

9. Clicking the 1 

button 

displays your 

Grand Total. 
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Let’s Remove our Subtotals. 

1. Click the Subtotals button, 

2. From the Menu for Subtotals Click the Remove All button. 

3. The subtotals are removed. 

Now, let’s see how often or how many times a customer ordered from 

us. 

1. First sort your Jan Worksheet by Customer – Click 

in the Customer column and Click the Sort 

Ascending (Sort A to Z) button on the Data Tab. 

2. After your data is sorted by customer, Click the 

Subtotal button in the Outline Group at the end of 

the tab. 

3. The Subtotals Dialogue box appears, as Pictured 

at right.  

4. Using the picture at right as a guide, At each 

change in:  Choose customer from the drop down 

box. 

5. Ensure Count Function is chosen in the Use 

function.  

6. In the “Add Subtotal to:” section have 

Customer Checked. 

7. Click OK. 

8. Click the 2 button on the expand and collapse 

section of the worksheet.  

Excel creates subtotals for each time the customer appears in the 

list and this is the number of orders we received from the customer. 

Remove your subtotals and save your workbook. 
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Mu l t ip l e  Su b to ta l s  

You may have more than one Subtotal displayed in your data table.  We’ll look at having our 

Sum, Average, and Count Functions on our previous table. 

Here’s how to have multiple Subtotals: 

1. Open your Track workbook and the Jan tab click in your data area. 

Ensure you have no subtotals displayed. 

2. Next, sort your data table alphabetically by 

customer, Click Subtotals at each change in 

Customer and Add a Sum Subtotal to Total as we 

accomplished in the previous section.  Excel Click Ok 

at the subtotal screen and Excel has your subtotals 

for each account summing the orders for you. 

3. As displayed at right, activate your Subtotal pane 

again and keep the At each change in: Customer, 

change the function to Average, and keep the Add 

subtotal to Total. 

4. UNCHECK the Replace current Subtotals and when 

you click OK, Excel add the Average Subtotal to your 

Sum Subtotal.  

5. Notice another level displays as circled below.  Click on the level 3 

and notice how you can view your subtotals by account with the Sum 

and Average functions. Next, click on the level 1 to view your Grand 

Totals.  
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6. Now, return to your Subtotal Pane and 

keep the At change in to Customer add 

the Count Function to Customer. 

7. Click OK and now Excel displays yet 

another Subtotal and level. 

 

I displaying level 4 below.  Return to Subtotals and Remove 

All. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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An Excellent Excel  Index  
 

= 

=AVG, 66 
=Count, 67 
=SUM, 63 
=YEAR, 93 

3 

3-D References, 61 

A 

Absolute Address, 60 
Add Scenario, 88 
Autofilter, 21 
Automatic Conditional Formatting, 109 
Autosum, 63 
Autosum Key, 63 
Average, 66 

C 

Calculation Box, 15 
Cell, 10 
Cell Referencing, 60 
Cell Styles, 31 
Clear Button, 38 
Collapse Button, 76 
Column Headers, 9 
Concatenate, 96 
Conditional Formatting, 105, 106 
Count, 67 
Create Names From Selection, 74 
Custom Conditional Formatting, 105 
Custom Filters, 42 
Custom Format, 106 
Custom Sort, 50 
Custom View, 53 

D 

Database, 34 
Database, 34 
Date Calculations, 92 
Date Custom Filters, 44 
Define Name, 74 
Defined Names, 74 
Design Tab, 32 

Dialogue Box Launcher, 25 

E 

Esc, 16 
Escape Key, 16 
Expand Button, 76 
Expand/Collapse, 128 

F 

Field List Pane, 120 
Fill Options, 56 
Filter, 38 
Filter Through A List, 35 
Filters And Sorts, 34 
Flash Fill, 56, 116 
Format As Table, 32 
Format Painter, 31 
Formula Bar, 9 
Formulas, 58, 59 
Freeze Panes, 122 
Function Arguments, 75 
Functions, 63 
Functions Keys, 30 

H 

HLOOKUP, 99 
Human Resources Analysis, 138 

I 

IFERROR Function, 104 
Insert Function Dialogue Box, 75 
Insert Slicer, 135 

K 

Key Tips, 28 

L 

Loan Calculation Workbook, 69 
Lookups, 99 

M 

Mathematical Operators, 58 
Microsoft Office Button, 7 
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Minimize The Ribbon, 24 
Mixed Address, 60 
More Functions, 66 
Multiple Filters, 39 
Multiple Subtotals, 149 

N 

Name Box, 9, 71 
Name Manager, 73 
Number Custom Filters, 42 

P 

Payment Function, 75 
Percent Sign, 70 
Pivotchart, 140 
Pivotcharts, 118 
Pivottable Styles, 123 
Pivottables, 118 
Pivottables Options Tab, 123 
Pivottables Tools, 123 
PMT Function, 69 

R 

Refresh, 129 
Relative Address:, 60 
Rename A Worksheet, 14 
Report Filter Pages, 131 
Resizing Columns And Rows, 14 
ROUNDDOWN, 93 
Row Headers, 10 

S 

Sales Tracking Analysis, 119 
Scenario Manager, 86 
Scenario Summary, 91 
Scenario Values, 89 
Scrolling Zoom, 16 
Select All Button, 9 

Show Formulas, 84 
Show Report Filter Pages, 132 
Show Values As, 137 
Slicer, 135 
Sort & Filter Group, 38 
Sorting, 47 
Sorting By Multiple Items, 50 
Sorting Command Buttons, 48 
Status Bar, 15 
Subtotals, 145 
Summarize Views By, 137 

T 

Text Custom Filter, 43 
Text To Columns, 112 
Text To Columns For Dates, 114 
Text Wrapping, 81 
The Ribbon, 8 
TODAY(), 92 
Toolbar Options, 17 
Top 10, 40 

U 

Undo, 49 

V 

VLOOKUP, 99, 100 

W 

What-If Analysis Button, 86 
Worksheet Navigation Buttons, 12 
Wrap Text, 81 

Y 

YEAR, 93 
Yes/No Filter, 45 

 
 


